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Preface

Thank you for purchasing OKI Multifunctional Digital Systems. This manual explains how to use the e-Filing. Read this
manual before using your Multifunctional Digital Systems. Keep this manual within easy reach, and use it to configure an
environment that makes best use of the OKI MFP’s functions.

Bl How to read this manual

0 Symbols in this manual

In this manual, some important items are descried with the symbols shown below. Be sure to read these items before
using this equipment.

A WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death, serious
injury, or serious damage, or fire in the equipment or surrounding objects.

A CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate
injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with
the following signs:

Tip Describes handy information that is useful to know when operating the equipment.
[ Pages describing items related to what you are currently doing. See these pages as required.

O Screens and Operation Procedures

* In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the installed
options, the OS version and the applications.

* If you use Windows Server 2008 R2, refer to the operation procedure for Windows 7, though the screens or the menu
names, etc. may differ.

* The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the
display or the order of buttons in the illustrations may differ from that of your equipment.
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O Trademarks

* The official name of Windows XP is Microsoft Windows XP Operating System.

* The official name of Windows Vista is Microsoft Windows Vista Operating System.

* The official name of Windows 7 is Microsoft Windows 7 Operating System.

* The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.

* The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.

* Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are
trademarks of Microsoft Corporation in the US and other countries.

* Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, and TrueType are trademarks of Apple Inc. in the US and other
countries.

* Adobe, Acrobat, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

* Mozilla, Firefox and Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and other
countries.

¢ IBM, AT and AlX are trademarks of International Business Machines Corporation.

e NOVELL, NetWare, and NDS are trademarks of Novell, Inc.

e Other company and product names given in this manual or displayed in this software may be the trademarks of their
respective companies.
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e-Filing OVERVIEW

This chapter describes overview of the e-Filing features and functions.

€-Filing Features.......... i 6
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e-Filing Features

The e-Filing is installed in a hard disk of this equipment. It allows you to store documents and to print/edit/manage the
stored documents.
This section describes the system of e-Filing for storing documents.

Control Panel

Client Computer

Documents stored by the
printing operation (printer
driver)

Documents stored by the
copying/scanning operation

=

Documents stored by

receiving Internet Fax / FAX

e

@Public Box
IjFolder % % % | |
= 5 5 | HH E
5 U U5 All users
UserBox
[:__JFoIder E: E: E:
Uz U5 U5 “ ’
= F 5 = 5 E
—V == L= Specified users
(or administrators)

Public Box

The public box is an e-Filing created by default. All users can access it, so it is suitable to store shared documents which
any user may need to work with. Since the public box is a built-in system box, you cannot change the name of the box /
create a new box / delete the box.

User Box

The user box is an e-Filing that each user can create. The user box can be protected by a password to limit access. It is
suitable for specific users or an administrator to store confidential documents. You can also create a user box without
setting a password. In this case, all users can access the user box as well as the public box.

(Up to 200 user boxes can be created.)

Folders

You can create folders in each box. However, you can create only one level of folders within each box. You cannot create
subfolders within folders.
(Up to 100 folders can be created in a box.)
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Documents
Documents can be stored in a box or folder in the following methods.

(Up to 400 documents can be stored in a box or folder. / Up to 200 pages can be contained in a document.)

* Copying documents and storing to e-Filing

¢ Scanning documents and storing to e-Filing

* Printing documents in a client computer and storing to e-Filing

* Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward functions.

* Received Internet Faxes / received faxes are forwarded to store to e-Filing using forward mailbox functions.

» Storing the received faxes is available only when FAX Unit (optional) is installed.
* Depending on the amount of data stored in e-Filing, it may take some time from when the equipment is turned on to
e-Filing becoming ready for use.

Tips

* For details of the forward functions, refer to the TopAccess Guide.
* For details of the forward mailbox functions, refer to the GD-1250/GD-1260 Operator's Manual for FAX Unit and
TopAccess Guide.

e-Filing Features 7



e-Filing Functions

M Functions operated with this equipment

Below is a list of e-Filing functions that you can operate with this equipment. For details of the operation, see the
references described below.

Q Printing documents

The following functions allow you to print documents stored in the e-Filing.
* To print an entire document

P.12 “Printing an entire document”
* To print specified pages of the document for confirmation

3 P.15 “Test print”

0 Storing documents

The following functions allow you to store documents in the e-Filing.
* To copy and store documents

[ P.17 “Copying and storing to e-Filing”
* To scan and store documents

3 P.22 “Scanning to e-Filing”

U Deleting documents

To delete documents in the e-Filing
3 P.24 “Deleting Documents”

0 Managing user boxes/folders

The following functions allow you to manage user boxes and folders in the e-Filing. You cannot create and edit folders in
boxes using the control panel. Folders can be created using a client computer.
* To create new user boxes
P.26 “Creating user boxes”
* To change the registered user box name and password
[0 P.29 “Editing user boxes”
* To delete user boxes and folders
0 P.31 “Deleting user boxes/folders”
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M Functions operated with a client computer

Below is a list of e-Filing functions that you can operate with a client computer (e-Filing web utility). For details of the
operation, see the references described below.

e-Filing web utility supports only Windows. Mac OS and other computers are not supported.

0 Managing user boxes/folders

The following functions allow you to manage user boxes and folders in the e-Filing.

To create new user boxes and folders

P.44 “Creating user boxes and folders”

To delete user boxes and folders

P.47 “Deleting user boxes and folders”

To edit (renaming and changing Properties) user boxes and folders
P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

0 Managing documents

The following functions allow you to manage documents stored in the e-Filing.

To display document image files in thumbnail view and list view
P.60 “Displaying documents”

To rename documents

D P.61 “Renaming documents”

To delete documents

P.63 “Deleting documents”

To print documents (entire document/test print)
P.64 “Printing an entire document”

[ P.67 “Selecting test print”

To store documents by printing operation

P.70 “Storing documents”

To archive documents

P.73 “Archiving documents”

To send documents as Emails

0 P.78 “Sending Email”

0 Editing documents

The following functions allow you to edit documents stored in the e-Filing.

To display document and page Properties

[ P.89 “Displaying document and page properties”

To copy/cut pages from a document and paste them into another one
P.90 “Copying pages from one document to another”

To copy/cut pages from a document and save them as a new document
P.95 “Copying pages from a document to a box or folder”

To delete pages from a document

LD P.99 “Deleting pages from a document”

To insert blank pages into a document

P.101 “Inserting a blank page into a document”

To move pages within a document to arrange the page order

P.104 “Moving pages within a document”

To move documents between boxes or folders

3 P.107 “Moving documents”

To copy an entire document and insert them into another document
P.109 “Merging documents”

Tips

* You can import e-Filing documents into a client computer using TWAIN Driver and File Downloader.
* You can back up or restore documents in e-Filing and various settings of e-Filing using the e-Filing Backup/Restore

Utility.
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OPERATIONS WITH THIS EQUIPMENT

This chapter describes e-Filing functions that you can operate using the control panel of this equipment.
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Printing Documents

You can print documents stored in the e-Filing using the control panel of this equipment.
P.12 “Printing an entire document”
P.15 “Test print”

M Printing an entire document
You can print an entire document.

1 Press the [e-FILING] button on the control panel.

USER
MENU FUNCTIONS INTERRUPT COUNTER

O'dE

rCOPY

= O @B

[ @ @
. TuvV WXYZ

01010

=

2 Select the box that contains a document you want to print.

¥ e-FiLNG ?
ooue: [
01 g 02 =g 003 e 004 g
Box UserBox01 UserBox0 L UserBox04 g
005 j 008 o w7 J a08 J 00 j 21
UserBox 05 UserBox06 UserBox07 UserBox08 UserBox09 W
BOX SETTNG

Press or to switch the pages. You can also specify the box number (3-digit) using the digital keys.

¢ Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In this case,

press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

Select BOX

Enter BOX Passw

BOX NUMBER 001

BOX NAME UserBox01

.

* If you enter an invalid password several times to open the box, you may not log in for a certain period since

it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

* The password input is displayed in the blank symbols.
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3 If the document is stored in a folder, select the folder and press [OPEN].

¥ eFILNG ?
» 001 UserBox01 E oo8)
Document | Folder Name Date,Time Paper Pages

| poci10 10,0432 Ad 1
Lo g
.’I
A RETURN I DELETE i

PRNT BOX SETTNG

If the document is stored outside of the folder, this operation is not necessary.

Select the document. To change the print settings, press [SETTINGS]. To perform
printing without changing them, press [PRINT].

| 7] poctiosos

10, 0604

Ad

¥ eFILNG ?
» 001 UserBox01 » Folder01 E oo8)
Document Name Date,Time Paper Pages

B | boctiosio

4 RETURN I DELETE i
PRNT

If you press [SETTINGS], proceed to step 5.
If you press [PRINT], printing will start. When you want to stop printing, see “Deleting print job” in step 6.

Tip

Press |EBB| to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

: = | to return to the list.

display its contents. Press

© eFILNG [ TEVPLATE |, I
» 001 UsarBox01 » Foldor01 _z]
Document Name b
1
.,"'
4 reren || oeere || sertns )| testeant )| oeen | [ § eant |
o
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5 Change the print settings as necessary.

You can operate the print settings as below. For step 3 to 8, when each button of the menu is pressed, the setting
screen appears. Perform the appropriate operations. These operations of settings are the same as the one of copy

N

A-‘iﬁ

(Ae mf
a3 |
=
B+ =]

ﬁ‘ﬁ
1

I SET TING_
Ll
] E;.

2 FNSHNG
E >

NONE

TMNE
w®  srae
1

>

5

EXIT

<§,| TRAY

PAGE
&, MUMBER

I — Mm.

»

6 7

_once |
F— —

8

;Ij

& FANT l

AR SBIA TS

modes. For details of the operation, refer to the Copying Guide.

1)

Select the paper feeder. However, if the selected paper size is different from the actual one, the selection will be
cancelled and automatic paper selection will be applied.

Key in the number of copies to be printed using the digital keys.

Select the duplex printing mode. If you do not want to print on both sides of the paper, select [1 SIDE] in the

menu.

Select the finishing mode. The available finishing modes differ depending on the type of finishing device

installed.

Select the receiving tray. This button is available only when the Finisher (optional) is installed.

Set the position and width of the margin.

Set the position of the date and time to be printed.
Set the position of the page number to be printed.

6 Press [PRINT].

SETTINGS

* Deleting print jobs

Follow the procedure below to stop the printing of the document (delete print jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the print job list or the scan job list.

JJ FINISHNG

>

NONE

EXIT

<§,| TRAY

»

™E PAGE
w® staw |2 e
> 4]
CANCEL l 4> _PANT
RS

3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting print jobs, refer to the Copying Guide.
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M Test print

You can print specified pages of the document for confirmation.

1 Press the [e-FILING] button on the control panel.

USER
MENU FUNCTIONS INTERRUPT COUNTER

O'dE

rCOPY

=1 O ®

[ @ @
TUvV WXYZ

PRINT @ @
Iy

2 Select the box or folder that contains documents you want to print.

¥ eFILNG ?
ooue: [
001 (17 003 004
Lk UserBox01 UsarBox02 UsarBox03 UserBox04 1
-
05 j 008 w7 j one j ) j 21
UserBox 05 UserBox06 UserBox07 UserBox08 UserBox09 W

BOX SETTNG

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are the same as
those for one of printing an entire document.
P.12 “Printing an entire document”

3 Select the document you want to print, and then press [TEST PRINT].

¥ eFfLNG ?
» 001 UserBox01 E gggl
Documant | Folder Name Date,Time Papar Pages
Folder01 11,0225
| DOC110509 10,0432 Ad 1
L/ g
P | cocitosio 10, 0645 ! 3
1
4 RETURN I DELETE I SETTNGS .I .I OFEN I {b PANT I
BOX SETTHNG b

Tip

Press |EJEJEJ to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

: = | to return to the list.

display its contents. Press
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4 Key in page numbers in [FIRST PAGE] and [LAST PAGE], then press [PRINT].

First Page

Last Paga

En
J o]

AlPages |

CANCEL 4 PANT

IS,

* Select [FIRST PAGE] or [LAST PAGE], then specify the page numbers using the digital keys on the control

panel.

* If you press the [CLEAR] button on the control panel, the value entered in the currently selected box can be

deleted.

* To print entire pages of the document, press [ALL PAGES].

* Deleting print jobs

Follow the procedure below to stop the printing of the document (delete print jobs).

1) Press [JOB STATUS].

2) On the job status menu, display the print job list or scan job list.
3) Select the job you want to delete, and then press [DELETE].

4) The delete confirmation screen appears. Press [DELETE].

For details of deleting print jobs, refer to the Copying Guide.

16 Printing Documents



Storing Documents

You can store documents in e-Filing using the control panel of this equipment.
P.17 “Copying and storing to e-Filing”
P.22 “Scanning to e-Filing”

2

» Store confidential documents in a user box protected by a password.

* Up to 400 documents can be stored in a box or folder, and up to 200 pages can be contained in a document.
However, the total storage capacity of e-Filing and the shared folder is approx. 27 GB. Documents can only be
stored within the storage capacity limit. The available space can be checked with the [Device] tab in TopAccess.

¢ Saving in the e-Filing is not for permanent use. Delete unnecessary documents immediately.
P.24 “Deleting Documents”

Tips

* When you store documents in user boxes and folders, you need to create them in advance.
P.26 “Creating user boxes”(Operating with this equipment)
P.44 “Creating user boxes and folders” (Operating with a client computer)

* You can set the storage period for documents in the Box Properties window in a user box. The documents will be
deleted after the specific number of days have passed.

P.54 “Modifying and displaying user box and folder properties” (Operating with a client computer)

H Copying and storing to e-Filing

You can copy and store documents in e-Filing. The e-Filing documents can be copied and stored at the same time.

* Documents, whose paper sizes are shown below, cannot be stored in e-Filing.
- Custom paper
- Non-standard size paper (bypass tray)
* A document stored by “Copying and storing to e-Filing” is suitable for output, but not for importing as an image into

a client computer. To get the best image quality for importing an image into your computer, store the document by
“Scanning to e-Filing”.
P.22 “Scanning to e-Filing”

Place the original(s) and set the copy mode as necessary.
For details of placing original(s) and copy mode settings, refer to the Copying Guide.

On copy mode settings, even when “TWIN COLOR COPY” or “MONO COLOR” is selected on the [IMAGE] tab,
this mode is invalid for storing documents in e-Filing. This mode is also invalid for copying documents at the
same time as storing them.

2 Press [STORAGE] on the copying screen.

PROOF COPY I

BN J08STATUS |

If the copying screen is not displayed, press the [COPY] button on the control panel.
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3 Press [STORE TO E-FILING].

@ CcoPY

READY

‘E‘ Eg?g COPY & FLE |
FOLDER B BOX No. E
BOX NAME | |
FOLDER NAVE |

DOCUNENT NANE |F0<:nﬂs1u |

RESET | CANCEL |

4 Press [BOX/FOLDER].

@ copyY

READY

STORE TOE-FLING COPY & FLE |

BOX [ FOLDER BOX Mo, C’
BOX NAME | |

FOLDER NAVE |

DOCUNENT NANE |F0<:nﬂs1u |

5 Select the box in which you want to store the data.

¥ eFILNG 7
e
= )| o 002 003 004

L N N~ N N
Box UserBox01 [ I e e |
e -
005 j 008 007 j 008 j 000 \g 21
UserBox 05 UserBox06 UserBox07 UserBox08 UserBox09 W |

Press or to switch the pages. You can also specify the box number (3-digit) the using digital keys.
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e Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In this case,
press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

BOX NUMBER 001

BOX NAME UserBox01

PASSWORD
r

NS

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access.
When “Box is locked.” appears and logging in cannot be performed, ask your administrator.

* The password input is displayed in the blank symbols.

6 To store the original(s) in the selected box, press [OK].

@ COoPY
READY
B 001 UsarBox01
Document | Folder Name Date,Time Paper Pages
Foldar01 11,0225
| DOC 110509 10,0432 Ad 1

e Storing in a folder
Select the folder and press [OPEN], the list in the folder is displayed. To store the original(s) in the selected folder,
press [OK].

@ COoPY
READY
B 001 UsarBox01
Document | Folder Name Date,Time Paper Pages
| DOC 11051 10,0432 Ad 1
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7 Change the document name as necessary, then press [OK].

DOCUNENT NANE |Focnﬂs1u |

FOLDER NAME

* Renaming the documents
When you press [DOCUMENT NAME], the on-screen keyboard is displayed. Key in the document name using the
keyboard and the digital keys (up to 64 characters), then press [OK].

DOG110510.

Basic =l Back Space I Clear

58 5 I 3 8 K K 6 I O S B

DDE DL DD DO
AJJo) Je) ) )]
D999 ) J e

Cme } o I Space I
omceL | %

For details of the on-screen keyboard, refer to the Quick Start Guide.

When the copy confirmation screen appears, press [YES] to store and print the
document. If you want to store the document without printing it, press [NO].

STORAGE SETTNGE . <y TEMPLATE .

Print this document?
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9 Press the [START] button on the control panel.

e Copying the next original
Depending on how the original is set, the confirmation screen to copy next the original may be displayed. Repeat
the procedure below as many times as necessary. When the scanning of the last page of the original finishes,
press [FINISHED].
* When the original is set on the glass, place the next original and press [YES]. When you press the [START]
button on the control panel, scanning will start.
* When the original is set on the RADF (Reversing Automatic Document Feeder)* in the SADF (single feed

mode), scanning will start when the next original is set. (You do not need to press any key.)
*  The RADF is optional.

SCANPAGE

JOB CANCEL .[XJFDEJI_” MNEXT COPY IJ

¢ Deleting scan jobs
Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting scan jobs, refer to the Scanning Guide.
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l Scanning to e-Filing

You can scan and store documents in e-Filing. When you import an original as an image into a client computer, it is
recommended to store the document using Scan to e-Filing.

To use this, the scanning function is required.

Place the original(s).
For details of placing original(s), refer to the Copying Guide.

2 Press the [SCAN] button on the control panel.

USER
MENU FUNCTIONS INTERRUPT COUNTER

rCOPY =3
== O @B
[ GHI JKL MNO

2| Q@O

3 Press [e-FILING].

& SCAN

Select Menu!

Destination Fika Mame File Format 5 PREVEW I

Tip

Set [SCAN SETTING] and check [PREVIEW] as necessary. These operations are the same as the one of other
scanning functions. For details of the operation, refer to the Scanning Guide.

Select the box or folder in which you want to store the documents. Change the
document name as necessary, then press [OK].

& SCAN

Select Menu!

BOX / FOLDER

DOCUMENT NAME I FWHOMD
v

) _owen J[ o]
2011/05/10

FOLDER NAME

The instructions of the operating procedure as to selecting a box/folder and changing a document name are
omitted, because they are the same as those for copying and storing to e-Filing.
P.17 “Copying and storing to e-Filing”
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5 Press [SCAN].

& SCAN

Select Menu!
Press SCAN to start scanning.

39&!\5]‘

SCANSETTNG .l

Destination Fika Mame File Format | 5 PREVEW I
1 ‘ﬂ UserBox01 DOC 110510

When the original is set on the RADF (Reversing Automatic Document Feeder)’, pressing [CONTINUE] on the
screen during scanning can start the scanning of another original after the current one.

P.23 “Scanning the next original”

*  The RADEF is optional.

The acceptable number for reserving scanning jobs differs depending on the settings. If the reserved jobs
exceed the corresponding number, the full reservation message will be displayed. In this case, wait until the
reserved scanning jobs are reduced or delete unnecessary reservations (scanning jobs) as described below.

¢ Scanning the next original
When the original is set on the glass or [CONTINUE] is pressed during scanning on the RADF, the confirmation
screen for the next original will be displayed.
In either case, when you set the next original and press [SCAN], it will be scanned. Follow this procedure as many
as times as necessary. When all of the scanning is finished, press [JOB FINISH].

SCANPAGE

.mcmcm_lscmscwnql JoBfNsH || ¢ SCAN |

A BIAIRS

* You can change the scan setting by pressing [SCAN SETTING].
* You can cancel the reservation of the scanned data by pressing [JOB CANCEL].

* Deleting scan jobs
Follow the procedure below to stop the scanning of the documents (delete scan jobs).
1) Press [JOB STATUS].
2) On the job status menu, display the scan job list.
3) Select the job you want to delete, and then press [DELETE].
4) The delete confirmation screen appears. Press [DELETE].
For details of deleting scan jobs, refer to the Scanning Guide.
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Deleting Documents

You can delete documents in e-Filing using the control panel of this equipment.

e-Filing is not designed for saving documents permanently. Delete unnecessary documents immediately.
Tip

If you delete a folder or box, all the documents in the folder or box are deleted as well.
P.31 “Deleting user boxes/folders” (Operating with this equipment)
P.47 “Deleting user boxes and folders” (Operating with a client computer)

1 Press the [e-FILING] button on the control panel.

USER
MENU FUNCTIONS INTERRUPT COUNTER

COPY
ABC DEF
— O @®
rSCAN @ @
PQRS TUV WXYZ

= | QOO

2 Select a box or folder that contains a document you want to delete.

¥ eflNG 2
woves
o1 002 =g 003 =m 004
mo UserBox01 UserBox0 1 UsarBox04 )
005 J 008 = 007 J o08 J 00 j 21
UserBox 05 UserBox06 UserBox07 UserBox 08 UserBox09 LV
~ DoXsETThG 4

The instructions of the operating procedure as to selecting a box/folder are omitted, because they are the
same as those for printing an entire document.
P.12 “Printing an entire document”
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3 Select the document you want to delete and then press [DELETE].

¥ eFfLNG ?
» 001 UsarBox01 E gggl
Documant | Folder Name Date, Time Paper Pages
Foldar01 11,0225
| Doci10509 10,0432 Ad 1

P | cocitosio 10, 0645 ! 3

W
A RETLAN I DELETE SETTINGS .I TEGTF‘RNT.I OPEN I 4 PANT I
PANT b BOX SETTNG

Tip

Press EEJEJI to preview thumbnail images of the documents. Select the desired one and press [OPEN] to

display its contents. Press | == | to return to the list.

When the confirmation screen appears, press [DELETE] to delete the selected
document.

¥ eflLNG ?
> 001 UsarBox| l gggl
Pages
Folder01
=T Are You sure you want to delete this document?
| poct1o 1

B | oot — =3 |

4 RETURN & PANT I

BOX SETTNG

PRNT

You can cancel the deletion of the selected document by pressing [CANCEL].
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Managing User Boxes/Folders

You can manage user boxes and folders in the e-Filing using the control panel of this equipment.
P.26 “Creating user boxes”

P.29 “Editing user boxes”

P.31 “Deleting user boxes/folders”

Tip

Folders can be created and edited using a client computer.

P.44 “Creating user boxes and folders”

P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

H Creating user boxes

You can create user boxes (up to 200).

1 Press the [e-FILING] button on the control panel.

USER
MENU FUNCTIONS INTERRUPT COUNTER

rCPY ABC DEF =

qu-Ne O
8 GHI JKL MNO

= @®®

PQRS UV WXYZ

= | DO @

2 Press the [BOX SETTING] tab, select an unregistered button numbered from “001” to
%2007, then press [SETUP].

¥ eFLNG 2

o e
[
&

UserBox 10

J

018

Press or to switch the pages. You can also directly specify the box number (3-digit) the using digital keys.

26 Managing User Boxes/Folders



3 Press [BOX NAME] and enter the box name.

T e \
BOX SETUP

Enter BOX name and Password

Box No o1

—
SSWORD I I l |

RETYPE PASSWORD I
.

T

A BIAIRS

* Entering box name
Press [BOX NAME]. The on-screen keyboard is displayed. Key in the box name (up to 32 characters) using the
keyboard and the digital keys, then press [OK]. However, the following one-byte characters cannot be used. A
space or period cannot be used at the beginning or end of the name. If these characters are keyed in, an error
message informing you of the invalid character used is displayed.
"B &'=|{}*<>?[];:1\,

UserBox 11

E
fasic | BackSpace | Ciar |
EFEFECEENEECEEEEE
EFELEEFDREEDEED

DODDOOBON
EEEEFECLDE L)

el I Space I
omceL | %

For details of the on-screen keyboard, refer to the Quick Start Guide.
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4 Enter the password in the [PASSWORD] and [RETYPE PASSWORD] boxes, then press
[OK].

Box Mo

o1
BOX NAME | P..eraox 11
-

PASSWORD J l ......

RETYPE PASSWORD ‘ """

* Press [PASSWORD] and then [RETYPE PASSWORD]. Enter the password using the digital keys or the on-
screen keyboard. You can also create a user box without setting a password. In this case, all users can access

the user box as well as the public box.
* If you press the [CLEAR] button on the control panel, the value entered in the currently selected box can be

deleted.

» If the entered password does not meet the Password Policy, a warning message appears. Enter the correct

one.
For details of the Password Policy, refer to the TopAccess guide.

* The password input is displayed in the blank symbols.
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H Editing user boxes

You can change the registered user box name and password.

1 Press the [e-FILING] button on the control panel.

USER
MENU FUNCTIONS INTERRUPT COUNTER

O'dE

rCOPY

=1 O ®

[ @ @
TUvV WXYZ

PRINT @ @
Iy

2 Press the [BOX SETTING] tab, select the user box that you want to edit, and then press

[EDIT].
¥ eFLNG ?
BOX NUMBER:
010 T 014
& 3 3 |~
UsarBox 10 2
15 018 o019 g
P

Press or to switch the pages. You can also directly specify the box number (3-digit) the using digital keys.

* Password entry
When the password has been set to the selected user box, the password entry screen is displayed. In this case,

press [PASSWORD], enter the password using the digital keys or the on-screen keyboard, and then press [OK].

BOX NUMBER 011

BOX NAME UserBox11

PASSWORD
r

Tips
* You can also enter the administrator password to open the user box instead of the password.
* The password input is displayed in the blank symbols.
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3 Change [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] as necessary, and then
press [OK].

BOX NUMBER: : 011

BOX NAME _| FiserBoxﬁ

PASSWORD

RETYPE PASSWORD

The instructions of the operating procedure of [BOX NAME] / [PASSWORD] / [RETYPE PASSWORD] settings are
omitted, because they are the same as those for creating user boxes.
P.26 “Creating user boxes”
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H Deleting user boxes/folders

You can delete user boxes and folders.

If you want to delete a folder or a box, all documents in the folder or the box are deleted as well.

1 Press the [e-FILING] button on the control panel.

USER
MENU FUNCTIONS INTERRUPT COUNTER

rCOPY [z3

— O@®

rSCAN @ @
éi PQRS Y WXYZ

= | (D®©®

2 Follow the procedure below to delete user boxes and folders.

* Deleting user boxes
Press the [BOX SETTING] tab, select the user box you want to delete and then press [DELETE].

¥ e-FiLNG ?

o j 11 ﬁ > o1 j 014 j

UserBox 10 UserBox 11

018

j 019 j

Al
2
-
21
v|

The instructions for the operating procedure for selecting user boxes are omitted, because they are the same as
those for editing user boxes.
P.29 “Editing user boxes”

¢ Deleting folders
Press the [PRINT] tab, select the folder you want to delete and then press [DELETE].

¥ eFfLNG ?
» 011 UsarBox i1 E oog)
Document | Folder Name Date,Time Paper Pages

| DOC110509 10,0748 Ad 1

E g

] poctiosio Xy’ 10,0748 Ad a| —
— 1
4 RETURN I DELETE

PRNT BOX SETTNG

The instructions for the operating procedure for selecting folders is omitted, because it is the same as the one of
printing an entire document.
P.12 “Printing an entire document”
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3 When the confirmation screen appears, press [DELETE] to delete the selected box/

folder.
¥ eFILNG ?
o ATTENTION

(Document in the BOX are also daleted)

10
‘P E
UserBox 10 Are you sure you want to delete this box? o
-
(1] 21
J DELETE CANCEL

E

You can cancel the deletion of the selected box/folder by pressing [CANCEL].
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OVERVIEW OF e-Filing WEB UTILITY

This chapter provides an overview of the e-Filing web utility features.
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Before Using the e-Filing Web Utility

Before using the e-Filing web utility, check the following items on your computer.
P.34 “System requirements”

System requirements
The e-Filing web utility works with the following browsers for the Microsoft Windows operating system:
* Microsoft Internet Explorer 6.0 or later (Internet Explorer 7.0 or later when IPv6 is used)
* Firefox 3.5 or later
¢ The minimum display resolution required for these browsers is 800 x 600.
* When using Internet Explorer, the Privacy setting must be set to Medium on the browser. Do not set Block All Cookies
or High for the Privacy function. For instructions on the Privacy setting, see the following procedure.
* Disable the popup block function of the Web browser. For instructions on how to set the popup block function, refer to
the HELP for the Web browser you are using.

e-Filing does not support access from Safari.

How to set the privacy settings in Internet Explorer
When you are using Internet Explorer, make sure that the Privacy setting is correct as follows.

1 Launch Internet Explorer and select [Internet Options] in the [Tools] menu.

& Tophccess - Windows Internet Explarer

() (@) hup/157.0973.052 Mami-DevIce HEEE

File Edit View Favarites Help

¢ Favorites | (@ TopAccest  Delete Browsing History... Ctrl+Shift+Del o
InPrivate Browsing Ctrl+Shift+P

Reapen Last Browsing Session

| InPrivate Filtering Ctrl+Shift+F ‘ Counter
InPrivate Filtering Settings

. Pop-up Blocker »

Device

SmartScreen Filter 3

Manage Add-ons

Compatibility View Alerts
Compatibility View Settings
v [
Windows Update [ [ososesesz
Develaper Taols F12 s
BFLE]

Intemet Optians Bvalsble | 26071 MB

% [Fa Space Avalate I

| Cartact Information

The [Internet Options] dialog box appears.

2 Display the [Privacy] tab and move the slider to “Medium” and click [OK].

Internet Options T[]
General | Security | Privacy | Content | Connections | Pragrams | Advanced
Settings I

]

Select a setting for th & nternet zone.

Medium

- Blocks third-party cookies that do not have 5 compact
privacy policy
- Blocks third-party cookies that sawe information that can

be used to contact you without your explicit consent
: - Restricts first-party cookies that save information that
<an be used to contact you without your implicit consent

| stes || mmpot || Advanced

Pop-up Blocker
[ 7| Prevent mast pap-up windows From
& appearing.
Turn on Pop-up Blocker
InPrivate
A% Do not collect: data For use by InPrivate Filtering

7 Disable toolbars and extensions when InFrivate Browsing
skarts

o [ o |
N3

The Privacy setting is saved.
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3 Exit from Internet Explorer and launch it again before accessing e-Filing.

Exit from Internet Explorer after accessing the e-Filing web utility. To log off from the e-Filing web utility in the
user mode, click the Log-out link and then exit from Internet Explorer.
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Getting Started With the e-Filing Web Utility

This section describes how to launch and exit from the e-Filing web utility. The way to launch the utility differs depending
on whether you log in as a user or a system administrator.

P.36 “Logging in as a user”
P.37 “Logging in as a system administrator”

M Logging in as a user

There are two ways to access the e-Filing web utility:

Click the e-Filing web utility link in the TopAccess web site.
Enter the e-Filing web utility URL in the address field of your Web browser.
The e-Filing web utility URL is: http://[IP address]/?MAIN=EFILING
The [IP address] portion will be the IP address of this equipment. You can also use the DNS name of this equipment
instead of the IP address.
For example, the IP address of this equipment is 192.168.1.2
http://192.168.1.2/?MAIN=EFILING
For example, the DNS name of this equipment is mfp-00000236
http://mfp-00000236/?MAIN=EFILING

If SSL is enabled for the HTTP network service, the e-Filing web utility will also be accessed by using SSL.

When the User Management Setting has been enabled, the log-in page will be displayed when accessing the e-Filing web
utility URL. In that case, please enter your User Authentication user name and password to log in to the main page of the
e-Filing Web Utility.

TopAccess

Login with your TopAccess User Mame and Password,

User Name Userl1
Password ssssss
Domain dept01

¢ If you enter an invalid authentication password several times to log into the OKI MFP, you may not be able to log in
for a certain period since it will be regarded as an unauthorized access.
* The password input is displayed in the blank symbols.

Tips

* Users can launch the e-Filing web utility to use its functions.

* Access to the e-Filing web utility will be timed out according to the Session Timer setting in the WEB General
Setting of TopAccess.

* To use the administrator’s functions of the e-Filing web utility, you must log in as a system administrator after
accessing it.
P.37 “Logging in as a system administrator”
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M Logging in as a system administrator

To log in as a system administrator, follow the steps below after launching the e-Filing web utility.

"System administrator" and "User with an administrator privilege" are defined as follows in this manual.
- System administrator:

User with the administrator role
- User with an administrator privilege:
User whose ID is "Admin"

1 Click the Log-in link located at the upper right of the page.

Documents Preferences

& < = =

L &

The Administrator Log-in page is displayed.

2 Enter the administrator password in the [Password] box and click [Login].

(¢ Electronic Filing

Administrator Login

Passward [ITTTT]

Top | Help

The [Administration] tab appears in the main tabs.

If you enter an invalid authentication password several times to log into the e-Filing web utility in the
administrator mode, you may not be able to login for a certain period since it will be regarded as an
unauthorized access.

* To log off from the e-Filing web utility in the administrator mode, click the Log-out link and be sure to close
your web browser to prevent unauthorized access by other users.

Tips
* The administrator password is the same as the password that has been set in the TopAccess or touch panel

display for the administrator. The default administrator password is “123456” if you have not changed it.
* The password input is displayed in the blank symbols.
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About the Main Tabs

The user interface of the e-Filing web utility consists of three main tabs located in the upper-right corner of the web
browser’s window: the [Documents] tab, [Preferences] tab, and [Administration] tab.

Documents Preferences Administration Logout

These main tabs enable you to display and work with your documents, set up viewing preferences, and perform
administrative functions.

P.38 “[Documents] tab”

P.40 “[Preferences] tab”

P.41 “[Administration] tab”

In addition, the Log-in link is located to the right of the main tabs which allows you to log in as a system administrator.
P.42 “Log-in link”

H [Documents] tab

The [Documents] tab is the default page and is available to all users. It consists of the Folders and Document frame, the
Menu Bar, and the Contents frame.

2 3
|
§ Electronic Filing | Login
[ [[s@sine <> |
Document {8 eFiling @ items)

1 — i e-Fiing

(gl Public Box
Eﬁ 001 User0l
&l 002 Userd2
&7 003 UserD3 @ ga ga ga —_— 4
&l D04 Userd4 ] ] ]

Eﬁ 005 Userd5
&l D06 Userds
&E 007 Userd?

[FlPublic Bax o001 userol [0z useroz [0z useros

Bl B B B

[Flo04 usero4 [Foos useros [Foo6 Useros o007 usero?

< +
Top | Help
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1) Document Frame
The Document frame is an Explorer-style user interface. Use the Folders and Document frame to locate the folders
and documents with which you want to work.
In the Document frame, the following icons are displayed according to the items:
- BoxIcons

r:_']'j This icon indicates a closed box.

ﬁﬂ This icon indicates an opened box.

-

z ]j This icon indicates a closed box that is protected by a password.

This icon indicates an opened box that is protected by a password.

Folder Icons
This icon indicates a closed folder.

This icon indicates an opened folder.

oD, &

Document Icons

r‘ = This icon indicates a document that was stored by a print operation. When the icon is displayed on a
& Igl white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

|=! =¥ This icon indicates a document that was stored by a scan operation. When the icon is displayed on a
5 white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

= |E| This icon indicates a document that was stored by a copy operation. When the icon is displayed on a
LA "] white background, it indicates that the document is currently in the View mode. When the icon is
displayed on a blue background, it indicates that the document is currently in the Edit mode.

|=l = This icon indicates a document that was stored by a fax operation via the mailbox function, fax received
[ﬁ' EEI forward function, or Internet Fax received forward function. When the icon is displayed on a white
background, it indicates that the document is currently in the View mode. When the icon is displayed on
a blue background, it indicates that the document is currently in the Edit mode.

This icon indicates a document that was created by merging several documents. When the icon is
displayed on a white background, it indicates that the document is currently in the View mode. When
the icon is displayed on a blue background, it indicates that the document is currently in the Edit mode.

2) Menu Bar
The Menu bar is located below the main tabs: File, Edit, View, and Layout.

3) Tool Bar
The Tool bar is located below the main tabs: Send Email, Save, Test Print, Cut, Copy, Paste, Beginning, Previous,
Next, and End. These buttons provide you with a one-click access to various functions.

Click this button to send the selected documents as Email.

Click this button to save the document. This is enabled only when you are displaying the document in the Edit
mode.
Click this button to perform a test print.

Click this button to cut the selected documents or pages.

Click this button to paste the items that have been copied.

Click this button to display the first items in the Contents frame.
Click this button to display the previous set of items in the Contents frame.
Click this button to display the items that immediately follow those displayed in the Content frame.

Click this button to display the last items in the Contents frame.

=
Click this button to copy the selected documents or pages.
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4)

Contents Frame

The Contents frame displays the documents or pages with which you are working. There are also document control
buttons located below the menu bar. You can use these buttons to change the document status between the View
mode and Edit mode, and use the Contents frame to print and edit your documents.

Tip
For more information about the document control buttons, see the following section:
P.88 “About the Document Control Buttons”

M [Preferences] tab

The [Preferences] tab is available to all users. It allows you to make the default condition for document viewing and the
number of thumbnail images displayed on the screen.

1)

2)

3)

4)

5)

¥ Electronic Filing Login
Preferences
41 —— Default Document view:  Thumbnail view -

2 —lpad 8 0+ thumbnails per view.

3 —_— Displaythe progress bar.

4 —5) [t
5 —

Top | Help

Default Document View

You can select the Thumbnail or List view. The system displays your documents by the selected view until you choose
another option from the View menu. The default is the Thumbnail view.

Load [number] thumbnails per view.

Use the drop-down list box to select the number of thumbnail images displayed on the screen as 4, 8 or 12. The default
is 8.

Display the progress bar.

Select the [Display the progress bar.] check box to display the progress bar when copying, cutting, or pasting the
documents or pages, deleting pages, or saving documents.

[Save]
Click this button to apply your new settings.

[Reset]
Click this button to restore the default settings.
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H [Administration] tab

The [Administration] tab allows the system administrator to manage the data in e-Filing. The [Administration] tab is only
visible if you are logged on as the system administrator.

The [Administration] tab has the following subtab:

P.41 “[Box Management] subtab”

B

An administrator can also set up the e-Filing notifications by using TopAccess in the administrator mode. For more
information about setting up the notifications for e-Filing, refer to the TopAccess Guide.

0 [Box Management] subtab

This subtab enables you manually to delete user boxes that are no longer required or have become corrupted. Use this
feature to restore the available hard disk space.
You can also unlock user boxes which have been locked by incorrect password entries.

¢ Electronic Filing
Eox Management
4 —— oFiling Disk Space Availatle - 10143 MD
Stored Data Data Type Data Size Remarks.
Box Shamid File ar N8
Uetete

2 e | a Pox Mumbes Box Naimd Usid capacity Stabus
a0 r STMB

nmMe

1) e-Filing Disk Space Available
This item displays the available hard disk space for storing the e-Filing data.

2) Box Number / Box Name / Used capacity / Status
This item displays a list of all user boxes. When you click a box number or box name link, the Box Properties window
opens and you can see the detail properties of the box. If the user box is locked, the lock status is displayed in the
results. To delete or unlock a user box, select the check box on the left of each property, and then click [Delete] or
[Unlock].

3) [Delete]
Click this button to delete the selected boxes. Before doing so, first select the check boxes of the user boxes that you
want to delete.

Tips

* You cannot delete the public box.
* Forinstructions on how to erase user boxes, see the following section:
P.114 “Erasing boxes”

4) [Unlock]
Click this button to unlock the selected boxes. Before doing so, first select the check boxes of the user boxes that you
want to unlock.

Tip

For instructions on how to unlock the user boxes, see the following section:
P.115 “Unlocking user boxes”
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M Log-in link

The Log-in link that is displayed next to the main tabs allows you to log in as a system administrator.
P.42 “Administrator log-in page”

You can perform the administrative function from the [Administration] tab that will be displayed after you log in as a system
administrator.

P.41 “[Administration] tab”

O Administrator log-in page
You must enter the system administrator password to log in as an administrator.

“§ Electronic Filing

Administrator Login

1 —Fasswor eesaes
2 ———[Logn] [ Cancel |
3 —

1) Password
Enter the system administrator password that is same as the administrator password on the touch panel display and
TopAccess.
2) [Login]
Click this button to log in as a system administrator.
3) [Cancel]
Click this button to cancel login and return to the main page.
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HOW TO MANAGE USER BOXES/FOLDERS

This chapter provides instructions on how to manage user boxes and folders by using the e-Filing web utility.

Managing User Boxes and Folders .........ccccccoiiiiiiiiiineimnnnssessss s ssnnsenes 44
Creating user boXes and fOIUEIS .........uiiiiiiie et e et sre e e en e enre e e 44
Deleting USer bOXES @Nd fOIABTS .......coiiiiiieiie ettt e e e st e e snt e e s ne e e smneeeenseeeeneeeeanneean 47
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Modifying and displaying user box and folder Properties .............coooeii i 54




Managing User Boxes and Folders

The e-Filing web utility provides two box types: the public box and user box. Each user can create his or her own user box,
and also create one level of folder in each box.

This section explains the following operations:

P.44 “Creating user boxes and folders”

P.47 “Deleting user boxes and folders”

P.50 “Renaming user boxes and folders”

P.54 “Modifying and displaying user box and folder properties”

Tip

For a detailed explanation of the public box and user box, see the following page:
P.6 “e-Filing Features”

H Creating user boxes and folders

Each user can create his or her own user box, and also protect the box with a password, if required.
P.44 “Creating user boxes”
P.45 “Creating folders”

U Creating user boxes
This operation allows you to create up to 200 user boxes and protect each box with a password.
Tip

You can also create user boxes from the control panel. For instructions on how to create user boxes from the control
panel, see the following page:
P.26 “Creating user boxes”

Click the [Documents] tab.
The [Documents] tab page is displayed.

Make sure that you are selecting “e-Filing” in the Document frame, and select [New
Box] from the [File] menu.

(“§ Electronic Filing Login
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The New Box window appears.

3 Define the box properties as required and complete the operation.

1) Select a box number in the [Box Number] box.
Users cannot select existing box numbers in the [Box Number] box. Only undefined box numbers appear in this
drop-down list box.

2) Enter the box name in the [Box Name] box.
Box names can consist of any ASCII characters except:\/<>"% & =";:*? | #[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a box name is 32 characters.

3) If you want to protect the box with a password, enter one in the [Box Password] and [Confirm Password] boxes.
The password input is displayed in the blank symbols.
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4) Click [OK].

New Box
Required
Biox Murnber: o0& - %1
“Box Name: Userg
Box Passwaord: sssses %2
Retype Passwaord ssssse
G [%3
A
V&

The created user box appears in the Document frame.

Tip
Users can configure advanced properties for each box such as how long the box will retain documents, and

Email notification features.
P.54 “Modifying box properties”

U Creating folders

This operation allows you to create up to 100 folders in each box.

Only single-level folders can be created in each box. You cannot create subfolders in the folders.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box where you want to create a folder.
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File  Edit _ Wiew o0
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Box Mumnber

Box Mame

Box Password :

Password Authentication

o0l

Userl1

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].

4 Click the [File] menu and select [New Folder].

(¢ Electronic Filing
File Edit View 1 ayout

1B e-Filing

Document

E g Public Box

= &9 001 User0dl
= fﬂ]j 002 Usero2
¥ 57 003 Userd®
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¥ & 005 Userds
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Archive Document
Upload Archived Document.

Test Print

Print Document

Send Email

The New Folder window appears.

5 Enter the folder name in the [Name] box and click [OK].

New Folder

Mame:

Folder01

\

The created folder appears under the selected box in the Document frame.

Folder names can consist of any ASCII character except\/<>"% &=";:*7?|#[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a folder name is 64 characters.
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This operation allows you to delete user boxes and folders.

P.47 “Deleting user boxes”
P.48 “Deleting folders”

Tip

H Deleting user boxes and folders

When the box has been protected with a password, you must enter it to delete the box and folders. Users with an
administrator privilege can delete all user boxes and folders by using their password.

Folders in the public box can be deleted, although you cannot delete the public box itself.

U Deleting user boxes

This operation allows you to delete user boxes. If a user box is deleted, all folders and documents in the box are also

deleted.

Tip

You can also delete user boxes from the control panel. For instructions on how to delete user boxes from the control

panel, see the following page:
P.24 “Deleting Documents”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to delete.
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3 If you select a user box which is protected with a password, the Password
Authentication window appears. Enter the password in the [Box Password] box and

click [OK].

Password Authentication

Box Mumber:

Box Mame :

Box Password

ak [ | Cancal |

oo

Userdl

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Click the [Edit] menu and select [Delete].
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The confirmation message dialog box appears.

5 Click [OK].

Message from wehpage ==

i &= | Do youwant to delete the item(s)?

= 0LUsenL
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The selected box is deleted.

U Deleting folders

This operation allows you to delete folders in the public box and user boxes. If a folder is deleted, all documents in the
folder are also deleted.

Tip
You can also delete folders from the control panel. For instructions on how to delete folders from the control panel, see

the following page:
P.31 “Deleting user boxes/folders”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folders that you want to delete.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber ont

Box Mame User(1

Box Password : sssses

(Ganeel

All folders and documents in the box are displayed in the Contents frame. n

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check boxes of the folders that you want to delete and select [Delete] from
the [Edit] menu.
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The confirmation message dialog box appears.

You can also delete a folder by selecting the folder in the Document frame, clicking on the [Edit] menu and
selecting [Delete]. In that case, make sure that no documents are selected in the Contents frame. If any
documents are selected, they will be deleted instead of the selected folder.

5 Click [OK].

Message from webpage ==

"% Do youwant to delete the itemis)?

© Folderl

Cancel |

The selected folders are deleted.
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Hl Renaming user boxes and folders

This operation allows you to rename the user boxes and folders.
P.50 “Renaming user boxes”
P.52 “Renaming folders”

Tip

When the box has been protected with a password, users must enter it to rename the box or folders. Users with an
administrator privilege can rename all user boxes and folders by using their password.

You can rename folders in the public box, but cannot rename the public box itself.

0 Renaming user boxes

Do not turn off the power of the equipment when changing the box name. All folders and documents in the box will be
lost if the power is turned off while the system is saving a new name.

Tip
Users can rename user boxes from the control panel. For instructions on how to rename user boxes from the control

panel, see the following page:
P.29 “Editing user boxes”

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box that you want to rename.
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If you select a user box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber oot

Box Marme : Userll

Box Password assses

0K [ | Cancel ‘
Notes

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].

50 Managing User Boxes and Folders



4 HOW TO MANAGE USER BOXES/FOLDERS

4 Click the [File] menu and select [Rename].

Electronic Filing

L

Document

{8 e-Filing
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Box

= A 001 Usernl
= &3 Folderol
ga 002 User02
0 003 Userd3
gi 004 User04
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Hew Folder
Open

Archive |".\ument
Upload Archwed Document

Test Print
Print Document
Properties

Send Email

[CIFoldero1

The Rename Box window appears.

Make sure that no folder or document is selected in the Contents frame. If a folder or document is selected, it

will be renamed instead of the selected box.

5 Edit the name in the [Name] box and click [OK].

Rename Box

Marme

‘ Used1

)

The confirmation dialog box appears.

Box names can consist of any ASCII characters except\/<>"% &=";:*?|#[]{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a box name is 32 characters.

G Click [OKI.

The selected box is renamed.
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0 Renaming folders

Do not turn off the power of the equipment when changing the folder name. All documents in the folder will be lost if the
power is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box containing the folder you want to rename.
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3 If you select a box that is protected with a password, the Password Authentication
window appears. In this case, enter the password in the [Box Password] box and click
[OK].

Password Authentication

Box Murmnber : on1

Box Mame Userl1

Box Password : sssses

0K [ | Cancel ‘

All folders and documents in the box are displayed in the Contents frame.

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check box of the folder that you want to rename and select [Rename] from
the [File] menu.
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Properties
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The Rename Folder window appears.

* Do not select several folders at the same time. You can only rename one folder at a time.

* You can also rename a folder by selecting the folder in the Document frame, clicking on the [File] menu and
selecting [Rename]. In that case, make sure that no document is selected in the Contents frame. If a
document is selected, it will be renamed instead of the selected folder.

5 Edit the name in the [Name] box and click [OK].

Rename Folder

Harme : Falde1

The confirmation dialog box appears.

Folder names can consist of any ASCII character except\/<>"% &=";:*?|#[]1{}. Do not use a space or
period at the beginning or end of the name. The maximum size of a folder name is 64 characters.

@ Click [OK].

Message from webpage (3]

|9_\ Do youwant ta rename the item?

4\
The selected folder is renamed.
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H Modifying and displaying user box and folder properties

This operation allows you to display and modify the properties of user boxes such as the box password and maintenance
period to automatically delete documents, and Email notification settings. This operation also allows you to view and
confirm the folder properties.

P.54 “Modifying box properties”
P.57 “Displaying folder properties”

Tip

When the box has been protected with a password, you must enter it to modify the box properties. Users with an
administrator privilege can modify all user box properties and public box properties by using their password.

0 Modifying box properties

* If you want to modify the public box properties, you must first log in as the system administrator.
* You cannot modify the password of a box that any user is currently accessing.

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the user box whose properties you want to display and

edit.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murmber: oot

Box Marme : User1
Bow Passward : LLITTTY

0K [ | Cancel ‘

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 HOW TO MANAGE USER BOXES/FOLDERS

4 Click the [File] menu and select [Properties].

Document
New Folder
{8 e-Filing Open
= 4 Public Box Ransme
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&g 007 Usern? Send Email

[CIFoldero1

The Box Properties window appears. In the Box Properties window, you can see the box properties.

5 If you want to edit the box properties, click [Change Properties].

Box Properties

Ei 001 Usernt

Contains. OFile(sy 1 Folder(s)

Preservation Period for Documents © -

Email Address for Molification

Created 2011.051009:03:22
Modified 2011.05.1009:03:22

[ 0K ] [ Change Properties %

The Change Box Properties window is displayed.

Tip

If you do not need to change the box properties, press [OK] on the above screen to complete the operation.
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6 Specify the following items as required and press [Save].

Change Box Properties

g o Userlt

Change Box Password

Change Preservation Period for Docurments inside Box

Delete document automatically

e-Filing Motification Events
Send Email when an error oceurs

Send Email when jobis completed

Advanced notification is sent hefore the date of file deletion. -[3] day(s) naotice

‘Sav% ‘ Cancel |

Change Box Password — Select this check box to edit the box password. When you select this check box, enter

the password in the [Old Password], [New Password], and [Confirm New Password] boxes.

¢ Old Password — Enter the current box password. This option is enabled only when you select the [Change
Box Password] check box.

* New Password — Enter the new box password. This option is enabled only when you select the [Change Box
Password] check box.

* Confirm New Password — Enter the new box password again. This option is enabled only when you select
the [Change Box Password] check box.

Tip
If you forget the old password, you can enter the administrator password in the [Old Password] box instead of it.

Delete document automatically — Select this check box to automatically delete the documents in this box. When

you select this check box, enter the number of days in the [Preservation Period for Documents] box.

* Preservation Period for Documents — Enter the number of days that the documents will be preserved. The
documents will be deleted after the specified number of days have passed. If you set this period to 1 day, the
document will be deleted automatically 24 hours later.

If a document is automatically deleted by the [Delete document automatically] function, the delete history is not
stored in the log.
For details of the logs, refer to the TopAccess Guide.

Send Email when an error occurs — Select this check box to send a notification message to the specified Email
address when an error occurs. When you select this check box, enter the Email address in the [Email Address]
box.

Send Email when job is completed — Select this check box to send a notification message to the specified Email
address when a job is complete. When you select this check box, enter the Email address in the [Email Address]
box.

Advance automatic delete notification — Select this check box to enable an Email notification message to be
sent to the specified Email address 3 days before it automatically deletes the documents. When you select this
check box, enter the Email address in the [Email Address] box.

* Email Address — Enter the Email address to which the notification will be sent.
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Tip
When the options “Send Email when an error occurs” and “Send Email when job is completed” are enabled,
you are notified of whether or not the following e-Filing operations are successfully completed.
- Scan to e-Filing
- Copy to e-Filing
- Print to e-Filing
- Fax/Internet Fax Received Forward to e-Filing
- e-Filing to Print
- e-Filing to Email

An administrator can configure the e-Filing notification setting in the TopAccess [Administration] tab -
Maintenance - Notification page. For more information, refer to the TopAccess Guide.

7 Click [OK] to close the Box Properties window.
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U Displaying folder properties
You can only view and confirm the folder properties. No operation to modify the folder properties is available.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box containing the folder whose properties you want
to display.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber ont

Box Mame User(1

Box Password : sssses

(el |

All folders and documents in the box are displayed in the Contents frame.

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the folder with the properties that you want to view and select
[Properties] from the [File] menu.
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The Folder Properties window appears. In the Folder Properties window, you can view the folder properties.

* Do not select several folders at the same time. You can only view the properties of one folder at a time.

* Users can also display the properties of a folder by selecting the folder in the Document frame, clicking on
the [File] menu and selecting [Properties]. In that case, make sure that no document is selected in the
Contents frame. If a document is selected, its properties are displayed instead of the selected folder.

5 Click [OK] to close the Folder Properties window.

Folder Properties

;] Fuolderd1

Location : e-Filingser01iFolder0t
Contains OFiles)

Created 2011.051009:03:38
Modified 2011.051009:03:38

R

The following information is displayed in the Folder Properties window:
Location — Displays the directory where the folder is located.
Contains — Displays the number of files the folder contains.

Created — Displays the date and time the folder was created.
Modified — Displays the date and time the folder was last modified.
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MANAGING DOCUMENTS

This chapter provides instructions on how to manage documents by using the e-Filing web utility.
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How To Manage Documents

The e-Filing web utility allows you to manage the documents stored in the e-Filing system.
This section explains the following operations:

P.60 “Displaying documents”

P.61 “Renaming documents”

P.63 “Deleting documents”

P.64 “Printing documents”

P.70 “Storing documents”

P.73 “Archiving documents”

P.78 “Sending Email”

M Displaying documents

Two ways are available to view your document image files. The document view options are:
* Thumbnail view displays several files from a selected box, folder or several pages of the selected document. This is
the default view. Use it to manage documents and files.
P.60 “Using the thumbnail view”

» List view displays file names and properties in a tabular format. Use it to manage boxes and folders containing a large
number of files.

P.61 “Using the list view”

O Using the thumbnail view

This is the default view, unless you choose a different one. It displays a small image of each file or folder (if you highlight a
box or folder in the left frame) or each page (if you highlight a document in the left frame) with the file name or page
number and a check box. Click the check boxes to select the files or pages that you want to move, copy, delete or print.
To return to the thumbnail view, go to the [View] menu and select [Thumbnail].
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0 Using the list view

This view displays boxes, folders, or file names with the properties and check boxes in a list format. You may find it more
convenient than the thumbnail view for managing boxes and folders that contain a large number of files. Click the check
boxes to select a single file or multiple files that you want to move, copy, delete or print.

To display your files by the list view, go to the [View] menu and select [List].
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l Renaming documents

This operation allows you to rename the documents.

Do not turn off the power of the equipment when changing the document name. The document will be lost if the power
is turned off while the system is saving a new name.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document you want to

rename.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murmber oo

Box Marme Userl1

Box Password LTI

Cancel

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the document that you want to rename and select [Rename]
from the [File] menu.

(¢ Electronic Filing
e Gt Wiew oo |

Document
{8 e-Filing
[ Public Box
E & 001 Usernl
] Folderdl
EDocnusm e
[FYelele SRl R Print Document:
&f 002 User02
&0 003 User0s
& 004 User04
&0 005 User0s Send Email
&f 006 User0&

&0 007 Usern? [FlFolderol

HNew Folder

Properties

4;._)OC11E|51D
\ [Scan]

The Rename Document window opens.

Tip
Users can also rename a document by selecting the document in the Document frame, clicking on the [File]

menu and selecting [Rename]. In that case, even if you select the check boxes of pages in the Contents frame,
e-Filing will only rename the selected document in the Document frame.

5 Enter the document name in the [Name] box and click [OK].

Rename Document

Name : DOC1105810
Cancel

The confirmation dialog box appears.

Document names can consist of any ASCII characters except\/<>"% &=";:*?|#[]{}. Do not use a space
or period at the beginning or end of the name. The maximum size of a document name is 64 characters.
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G Click [OK].
Message from webpage

-9\ Da youwant ta rename the item?
OK r | ‘ Cancel
A\

The document is renamed.

H Deleting documents
This operation allows you to delete documents from the box or folder.

Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the documents you want to
delete.

(g Electronic Filing

Document B w-Filing (7 itams)

183 e-Filing
= [-g Public Box
# G 001 User0l
= ﬂ|j 002 Usero2
# 59 003 User0z o [z
2 gg 004 Userds ! ]j g
¥ 57 005 Userds
= ﬂ]j 006 UserOf
¥ 5@ 007 Userd?

Public Box 001 User0l

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication
Box Mumber oot

Box Marme User1

Box Password ssssse

0K D ‘Cancel
Notes

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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Select the check boxes of the documents that you want to delete and select [Delete]
from the [Edit] menu.

(¢ Electronic Filing
Fle  Eit  Wiew o0 |

Document o U Select Al
Invert Selection
{8 e-Filing -
[ Public Box
E & 001 Usernl
0] Folder0l
[& poc110s10
|ch DOC110810-001
&F 002 Usernz G
&0 003 User0s
&F 004 Usero4
&0 005 User0s
&F) 006 User0s
i 007 User07 [Crolderot

Cut
Copy

DOC110510

k [Scan]
1

The confirmation dialog box appears.

Users can also delete a document by selecting it in the Document frame, clicking on the [Edit] menu and
selecting [Delete]. In that case, make sure that no pages are selected in the Contents frame. If any pages are
selected, the alert message will be displayed because pages cannot be deleted in the View mode.

5 Click [OK].

Message fram webpage =]

% Do you want to delete the item(s)?

~ DOCLL510

Wk\ e

The documents are deleted.

M Printing documents

You can print documents and images from boxes and folders in the e-Filing web utility. The following two ways are
available to print them:

P.64 “Printing an entire document”

P.67 “Selecting test print”

O Printing an entire document
This operation allows you to print the entire document with various print options selected.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want
to print.

¢ Electronic Filing

File Edit View Layolt

Document B eFiing @ tems)

{8 e-Filing
[ Public Box
# 5 001 Userol
& 57 002 Usern2
E & 003 User03 e £
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber oo

Box Marme Userd1

Box Password LLITLT)

Cancel

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.
* The password input is displayed in the blank symbols.
Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the document that you want to print and select [Print
Document] from the [File] menu.

@ Electronic Filing
[Fle Bt WView oo |
R

Document

New Folder

18 e-Filing Open
[ Public Box femame =
= &9 001 User0dl Archive Document

=] Faldero1 Upload Archived Document.
| DOC110510 e
[Qa DOC110510-001
&0 002 Usernz mkﬁ
5F 003 User3 " 2
&0 004 Usern4 - =
&F 005 User0s Send Email
&0 006 Userds

ga 007 Userd? [CIFalderol

l¥lboc110s10
K [Scan]

The Print window appears.

You can also print a document by selecting it in the Document frame and [Print Document] on the [File] menu.
However, you cannot print individual pages even if you select the check boxes of the pages displayed in the
Contents frame.
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5 Select the following print options as required and click [Print].

Print
Duplex: Mohe - . CoverfSheet Insertion:
Mumber of Copies: 1 Use Front Cover
@ Sort Copies Auto Select
Group Copies = HRE] Do not print on page
Use Back Cover
Paper Type: Plain - Auto Select
Do not print on page
’7 Insert Pages
Paper Source: Auta Select - Auto Select
Destination: Receving Tray - Do not print on page
Hone ]
Hone Interleave Pages
Mone &suto Select
Page Number:
Position: Mane hd Flain
Initial Page: ,7 Scheduled Print
Year Month Date  Time
Time Stamp: o 5 el M- |
Pasition: Mane -
Image Shift:
Pasition: Mane -
0
0
[Print] [Cancel | [Reset]

Duplex — Select whether you want the document printed on both sides of the paper. When you want to print the
document on both sides, select the Book option to print vertically in the same direction to be bound along the
vertical side of the paper so that the pages can be turned over right and left, or the Tablet option to print with a
vertical reversal to be bound along the horizontal side of the paper so that the pages can be turned over up and
down.

Number of Copies — Enter the number of copies to be printed.

The selectable range of the number of copies:
- 1 copy to 999 copies

Sort Copies — Select this option to output the document separately for each copy.
Group Copies — Select this option to output the document separately for each page.
Rotate Sort Copies — Select this option to output the document by changing the output orientation of each
copy. This option is enabled only when you enter more than one copy in the [Number of Copies] box. When this
option is selected, the Destination option is automatically set to the inner tray. To perform the Rotate Sort
Copies, the portrait and landscape paper must be set in different drawers.
Paper Type — Select the type of paper desired.
Department Code — Enter the 1 to 63-digit department code, if required. You must enter the department code to
print a document if the department code is enabled on the equipment.
Paper Source — Select the paper feed source. Select a paper source that correlates with the printing size.
Destination — Select the tray to which the document will be output.
Staple — Select whether the document is to be stapled or not. When you want to staple the document, select how
it will be done.

If you enable the Staple option after enabling the Interleave Pages option, the latter will be automatically
disabled.

Binding — Select this option to output the document folded or stapled at the center. You can set how the
document is output.

* Center Fold — The document is folded at the center.

* Saddle Stitch — The document is double-stapled and folded at the center.

“Binding” is enabled only when the optional Saddle Stitch Finisher is installed.
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Hole Punch — Select whether the document is to be hole-punched or not. When you want to hole-punch the
document, select how it will be done.

Page Number - Position — Select whether the page numbers are to be printed on the pages. When you want to
print the page numbers, select where it will be done.

Page Number - Initial Page — Enter the first number that applies to the first page of the document. When the
Cover/Sheet Insertion - Use Front Cover option is enabled, the front cover is counted as the first page, and the first
page of the document is counted at the second page.

Time Stamp - Position — Select whether the print time is printed on each page or not. When you want to print the
time stamp, select where you want it to be done.

Image Shift - Position — Select whether the printed images are to be shifted or not. When you want to shift the
printed images, select it to be done.

Shift Margin - Front — Select the width of the margin that is to be added to the side when the printed images are
shifted.

Shift Margin - Back — Select the width of the margin that is to be added to the opposite side when the printed
images are shifted.

Cover/Sheet Insertion - Use Front Cover — This option sets front cover printing which allows you to insert or
print a cover on a sheet fed from a different tray than the Paper Source option. To enable front cover printing, select
the check box and specify the location from where the cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Use Back Cover — This option sets back cover printing which allows you to insert or
print a cover on a sheet fed from a different tray than the Paper Source option. To enable back cover printing,
select the check box and specify the location from where the cover sheet is to be fed and the print style to be used.
Cover/Sheet Insertion - Insert Pages — This option sets sheet insertion printing which allows you to insert a
sheet between pages, or print a specific page on a sheet fed from a tray other than the Paper Source option. This
option is useful when you want to insert a blank sheet between chapters, or when you want to print chapter cover
pages on different paper. To enable sheet insertion printing, select the check box and specify the location from
where the inserted sheets are to be fed and the print style to be used. Then enter the page numbers you want to
insert, separating them with commas if multiple pages are specified, in the [Pages] box.

Cover/Sheet Insertion - Interleave Pages — This option sets the interleaving page feature that is useful when
you want to insert paper of a different type (or from another source) between every page of your print job. For
example, you could use this option to insert blank, colored sheets between overhead transparencies. To enable
interleaving pages, select the check box and specify the location from where sheets are to be fed. Also, select the
[Duplicate] check box if you want to print the previous page images on the inserted sheet.

If you enable the Interleave Pages option after enabling the Staple option, the latter will be automatically
disabled.

Paper Type (Insert) — When you select the Bypass Feeder option for the paper source of either the Use Front
Cover, User Back Cover, Insert Pages, or Interleave Pages option, select the paper type for the paper fed from the
bypass tray.
Tip
When both the user management and department management settings are enabled, the quotas that are
allowed for the department and user will be displayed in the upper right-hand area of the page.

Scheduled Print — Select this option to print a job at a future date and time. When this option is selected, set the
date and time to print the job in the [Date & Time] box.
Tips

* Clicking [Print] prints the document, and the print result window is displayed.
* Clicking [Cancel] closes the Print window without printing.
* Clicking [Reset] restores the default print properties settings.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] tab >
[Print], select the job and press [Delete].

L Selecting test print

This operation allows you to simply print a copy of a document by using the default print properties settings.
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Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want

to print.
[“§ Electronic Filing
File Edit. View Layoit
Document B eFiling @ tems)
{8 e-Filing

g Public Box

= ﬂ]j 001 User0l
¥ 5 002 Userd2
[ 57 003 User03
= ﬂ]j 004 User04
¥ & 005 Userds
= b]j 006 UserOf
¥ 5 007 Usern?

&5 Bl

[FlPublic Bax [Flo01 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murnber oo

Box Mame Userd1

Box Password [LTTTT)

Cancel

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to print and select [Test Print] from
the [File] menu.

(¢ Electronic Filing

Document
18 e-Filing

New Folder
Open

[f Public Box
= &9 001 User0dl
] Folderol

| DOC110510
[Qa DOC110510-001

&0 002 Usernz

#f 003 User0a

&0 004 Usern4

#f 005 User0s

&0 006 Userds

& 007 User0?

Rename
Archive Document

Upload Archived Document.

Print Docu g\t

Properties
Send Email

[FIFalderol

The Test Print window appears.

110510
[Scan]

You can also perform test printing by selecting a document in the Document frame and then selecting [Test
Print] on the [File] menu. However, you cannot print individual pages, even if you select the check boxes of the
pages displayed in the Contents frame.
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5 Select whether to print all pages of the document or only specified pages and click
[Print].

Test Print

@ AllPages

1 -3 Fages

‘F‘Mml | Cancel

All Pages — Select this option to print all pages of the document.

[first page number] - [last page number] Pages — Select this option to specify the pages to be printed. When

this option is selected, enter the numbers of first page and last page to be printed in each box.

Department Code — Enter a department code. This must be entered only when the department code is enabled H
on the equipment.

Tips

* When both the user management and department management settings are enabled, the quotas that are
allowed for the department and user will be displayed in the upper right-hand area of the page.

* Clicking [Print] prints one copy of the document and the print result window is displayed.

* Clicking [Cancel] closes the Test Print window without printing.

6 Click [Close] to return to the [Documents] tab page.

When you want to cancel a job before printing is complete, access TopAccess, click the [Job Status] tab >
[Print], select the job and press [Delete].
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H Storing documents

From an application that runs under the Windows operating system, you can send a document as a print job to e-Filing
with the printer driver.

You can store your documents in the public box or in a user box.

P.70 “Saving a print job in the public box”

P.71 “Saving a print job in a user box”

To use this function, the printing function is required.

When you store a document in e-Filing by using the printer driver, the printed image (not the original document in your
computer) will be stored in e-Filing.

Tips

* For more information about the printer driver, refer to the Printing Guide.

* For a detailed explanation of the public box and user box, see the following page:
P.6 “e-Filing Features”

* You can also store a scanned document in e-Filing by using the control panel. For details, see the following page:
P.17 “Storing Documents”

U Saving a print job in the public box
1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

3 Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

Tip

The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be different
depending on the application that you are using. Refer to your application manual about displaying the [Printing
Preferences] dialog box.

4 Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.

2) Select other print options as required.
3) Click [OK].

=% Printing Preferences 5

Basic | Finishing | Paper Handing | Image Quaity | Eifect | Others | Templates

Print Job: Original Paper Size:

| Namal Print - (| Letierig 1,211 M|
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U Scheduled Print e
& Piivate Print i —
E Proct Frint Paper Source:
|2 Hold Print S|
W Fint to ety File PaperTopz:
| Piain x|
Oestinations
(8] [Esic Ty -
JJJ1 23 JJJT 2.3
J —
| Sellings W 7 2 ()
Profils -
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[Save Profie| | Dozt @ Portrait Landscape

Color:
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5 Select [Public Box] to save the print job and click [OK].

Store to e-Filing =23l
Store to Passmord
000 Public Be |
Box Folder 1
Erint
ok ] | Gancal |
Tips

* If you print a job as well as saving it in the public box, select the [Print] check box.
* If you want to save a print job in a specified folder, enter its name in the [Box Folder] box.
To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

Click [OK] or [Print] to save the print job.

The print job is saved in the public box.

0 Saving a print job in a user box

1 Open the document that you want to store in the box.

2 Click the [File] menu and select [Print] in your application.
The [Print] dialog box appears.

3 Select the printer driver of the equipment to be used and click [Preferences].
The [Printing Preferences] dialog box appears.

Tip

The procedure for displaying the [Printing Preferences] dialog box for the printer driver may be different

depending on the application that you are using. Refer to your application manual about displaying the [Printing
Preferences] dialog box.

4 Select the print job type on the [Basic] tab.
1) Select [Store to e-Filing] in the [Print Job] box.
2) Select other print options as required.
3) Click [OK].
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5 Select a user box to save the print job.
1) Select the desired user box number from the [Store to] box.
Enter the password for the user box in the [Password] box.

2)
3) If you print a job as well as saving it in the user box, select the [Print] check box.
4) Click [OK].

Stere to e-Filing ===

Store fo: Password:

(001 User01 o] 200080

B Folder %

Folder 1 1 2
Print

|§3 [T | Gancel |

Ng

Tip
If you want to save a print job in a specified folder, enter its name in the [Box Folder] box.

To save data in an existing folder, enter its folder name in the [Box Folder] box.
To create a new folder and save data in it, enter the new folder name in the [Box Folder] box.

If the Enable SNMP Communication option is enabled on the [Configuration] tab, only the user boxes that have
been set up will be displayed in the drop-down list box.

6 Click [OK] or [Print] to save the print job.

The print job is saved in the specified user box.
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H Archiving documents

The e-Filing web utility allows you to archive the documents stored in e-Filing and download the archived files to your
computer. These files can also be uploaded from your computer to e-Filing in the equipment, or other equipment of the
same OKI MFP series.

P.73 “Downloading an archived document”

P.76 “Uploading archived documents”

The archive files are compatible with the same series of the OKI MFP, not with another series. For example, archived
files downloaded from the ES9460 MFP can be upload in the ES9460 MFP, ES9470 MFP, CX3535 MFP or CX4545
MFP, not in the ES1960 MFP and ES1970 MFP.

U Downloading an archived document H

You can archive the documents in the box and download it to your computer. Use this feature to create a back-up file of
your documents in e-Filing.

The following procedure describes an example of how to download an archived document when using Microsoft Internet
Explorer.

* The archived file contains all the documents you have specified to the archive, but you cannot open the documents
on your computer.

* You can create an archived file that contains multiple documents in the same folder or the same box.

* You cannot create an archived file that contains more than 2 GB of data.

* Do not close the main window and child window by clicking [X]. If you do, downloading the archived documents
becomes impossible. If you close the window by clicking [X] by mistake, turn the power to the equipment off and
then on again.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want
to archive.

[“§ Electronic Filing

Document B e-Filing (8 items)
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber oo

Box Marme Userd1

Box Password LLITLT)

Cancel

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

Select the check box of the document that you want to archive and select [Archive
Document] from the [File] menu.

@ Electronic Filing
[Fle Bt WView oo |
R

Document
New Folder
18 e-Filing Open
[ Public Box fename
= &9 001 User0dl
] Folderol
E‘? DOC110510 e
[ DOoC110510-001 | EPENETE
&0 002 Usernz -
#f 003 User0a
&0 004 Usern4 -
&F 005 User0s Send Email
&0 006 Userds

ga 007 Userd? [CIFalderol

Upload Archived D(\'ﬂ:ﬂl

Properties

Iwlboc110s10
\ [Scan]

The confirmation dialog box appears.

Users can also archive a document by selecting the document in the Document frame, clicking on the [File]
menu and selecting [Archive Document]. However, you cannot archive individual pages, even if you select the
check boxes of the pages displayed in the Contents frame.

5 Click [OK] to start archiving the document.

Message from webpage @

I % Do youwantta archive the document?
\ This process may take some time.

o] Cema |
W
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The Archive Document window appears. During archiving, you can quit the process by
clicking [Cancel].

Archive Document

This process may take some time

Please wait while the document is compressed and a downloadable archive file is created

65 %

Cancel ‘

When archiving the document has been completed, “Your document has been archived successfully” is displayed. H
Do not perform any operation while the e-Filing web utility is running busy.

7 Click the file name link to download the archived file.

Archive Document

Your docurnent has been archived successfully.
Please click the link below.

You can now download the archived file onto your system.
The link will launch a file download dialog allowing you to select a name and path for the zip file

File Mame: 20110510_15442.zip
Created 05:10:2011 09.40:42 %

Size (KB): 21 MB

[ Close |

The [File Download] dialog box appears.

8 Click [Save].
File Download ==

Do you want to open or save this file?

Name: 20110510_15442zip
Type: Compressed zipped Falder, 21,9MB
From: 157.69.73.250

Open | [ Save | cancel
7] Always ask before opening this ype of fle

| Whikefles from the Intemet can be useful some fles can potentiall
g harm your computer. If you da nat iust the source, da not open of
sawe this file. What's the risk?

The [Save As] dialog box appears.
9 Locate the folder where you want the archived file saved and click [Save].

Save As
@@\vlz Desktop » [ 43 |[ Search Desit )
Organize ¥ New foldes = @

[ Favorites T | ibraries
B Deskop System Folder
a
I8 Downloads
5| Recent Places Usertol
.2 System Folder
Y s
S Libraries i
Computer
System Folder
1% Computer
Hetwark
€ Metwork System Folder
‘ Drivers
fill  Fiefolder
File neme: 20110510 15442 z
Save = type: | Compressed (zippet) Folder -
= Hide Falders |£k§\ [ cancer |
\S

This starts downloading the file.
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10 Click [Close].

Archive Document

Your document has been archived successfully.

Please click the link below

*fou can now download the archived file onto your system

The link will launch a file download dialog allowing you to select a name and path for the zip file
File Marme: P0110510_ 15442.2ip

Created 05:10:2011 09:40:42

Size (KB): 21 WA

Close,

0 Uploading archived documents

If you have an archived file that has been downloaded from the equipment to your computer, you can upload it to e-Filing.
When you upload the archived file, the file is automatically extracted and documents will be created in the box specified.

* If the same name document already exists in the box, the extracted document will be renamed by adding a 3-digit
number to the original name.

* Do not close the main window and child window by clicking [X]. If you do, uploading the archived documents
becomes impossible. If you close the window by clicking [X] by mistake, turn the power to the equipment off and
then on again.

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder where you want to upload the archived
documents.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murnber o0z

Box Mame Userd2

Box Password [LTTTT)

Ok D ‘ Cancel ‘
Notes

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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5 MANAGING DOCUMENTS

4 Select [Upload Archived Document] from the [File] menu.
(¢ Electronic Filing
ESes s

Document
New Folder
{8 e-Filing Open
[ Public Box Ransme
@ 001 Usern1 Archive Document
= Zf 002 Usern2
) Foldero2 e — k
0 003 Userds Print Document.

& 004 User0s
&0 005 Userns
&7 006 User0&
&g 007 Usern? Send Email

Properties

[CIFolderoz

The Upload Archived Document window appears.

5 Click [Browse].

Upload Archived Document

frchived File : \ Browse [

The [Choose File] dialog box appears.
6 Select the archived file to be uploaded and click [Open].

wa\ 1 v Achive » ~[ 2| Seorc o]
Organize »  Newfolder =+ 0 @
T Favorites 2011051015442

B Desitop 4 Compresicd fippe) Foldzr
[ Downloads k
%] Recent Places 1
G Libraries
B Camputer
@ Netwark
File name: 20110510_15442 * | AllFiles (") h

w2

This will return you to the Upload Archived Document window, and the folder path of the selected file will be
displayed in the [Archived File] box.

7 Click [OK].

Upload Archived Document

Wrchived File @ C\Users\Used01\DesktoptArchivelz | Browse

Lok [ cancel |

A3

The confirmation dialog box appears.
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8 Click [OK] to start uploading the archived file.

Message from webpage

Do yau want to upload the archived file?
This process may take some time,

QK | | Cancel
N

\\)

If you select an archived file unsupported in your model or a file other than an archived one, an error message
appears. In that case, select the correct archived file and try again.

The Upload Archive Document window shows the process of uploading. During the
uploading process, you can quit uploading by clicking [Cancel].

Upload Archived Document

This process may take some time

Please wait while the archived file is uploaded to the selected box.

When uploading the archived file has been completed, “Your document has been uploaded successfully” is
displayed.

Do not perform any operation while the e-Filing web utility is running busy.

10 Click [Close].

Tpload Archived Dacument

Your document has heen uploaded successfully.

Clnsel

The documents are added to the selected box.

H Sending Email

You can send the selected documents as Emails from the e-Filing web utility.

When you perform this function, the equipment creates an Email with the selected documents as an attached file and
sends the Email directly from the equipment.

To use this function, the scanning function is required.

¢ To use the Send Email function, the Email configuration of the equipment needs to be set by the network
administrator.

* You can send the e-Filing documents as Emails only when they have been saved under the conditions noted
below. Check the document properties before sending the documents.

- Documents which were saved with the copy function of the equipment in the black - TEXT/PHOTO or black -
TEXT mode

Documents which were saved with the scanning function of the equipment
Documents which were saved with the received fax/Internet Fax transferred function
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Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document that you want
to send as an Email.

[“§ Electronic Filing
File Edit. View Layout

Document B eFiling @ items)
{8 e-Filing
g Public Box
# 5 001 Userol
& 57 002 Usern2
[ 57 003 User03 Fﬁ ﬁ'a
E &g 004 User0s &
[ 57 008 User0s
¥ 5p 006 Userds

¥ 5 007 Usern?
[FlPublic Bax [Flo01 userol

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Murnber oo

Box Mame Userd1

Box Password [LTTTT)

Cancel

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

4 Select the check box of the document that you want to send as an Email and select
[Send Email] from the [File] menu.

@ Electronic Filing
[Fle Bt WView oo |
R

Document
New Folder
18 e-Filing Open
[ Public Box femame =
= &9 001 User0dl Archive Document
7 Folderol Upload Archived Document
| DOC110510 TestPrimt

[ DOoC110510-001 | EPENETE
&0 002 Usernz
#f 003 User0a
&0 004 Usern4
#f 005 User0s
&0 006 Userds
& 007 User0?

Properties

lwlboc110s10
[Scan]

1
The Send Email page is displayed.

Tips

* Users can also send a document as an Email by selecting the document in the Document frame, clicking on
the [File] menu and selecting [Send Email].

* Users can also send up to 100 individual pages or documents by selecting the check boxes displayed in the
Contents frame.
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5 Specify the following items as required and click [Send].

Send Email
| TO: Destination Setting |
T Destination [ single
‘ GC: Destination Setting |
CC: Deatination ]
| BCC: Destination Setting |
ECC: Destination I
Email Setting
*Required -
@ Send data from (Device name) (Box Info.)
Subject [
Add the date and time {0 the subject
*From Address Uzerl@example.com
Fram hams Userd1
Body
File Format POF(Multiy
¥| Encryption
UserPassword  |ssssssssssssssessa Retype Password (sssssessssssssssss
Masier Password [sssssssssssssssasa Retipe Password [sssssssssssssssssa
Encryption Level  126-bit AES ~
Rt ey Authority
¥ Printing
¥ Change of Documents
¥ Content Copying or Extraction
¥ Content Extraction for accessibility
@ DocYYMMDDOYYMMOD is a date)
File: hlame Qriginal Document Name
Fragmert Message Size Mo Fragmentation
[Send | Cancel || Reset |
\

[TO: Destination Setting] — Click this button to specify the destination. When you click this button, the Recipient

List page appears. For instructions on how to specify the destination, see the following section:

P.82 “Destination setting”

[CC: Destination Setting] — Click this button to specify the CC destination.

[BCC: Destination Setting] — Click this button to specify the BCC destination.

Subject — This option sets the subject of the Email documents. Select [Send data from (Device name) (Box Info.)]

set by default, or enter the desired subject in the box. When you want to add the date and time to the subject,

select the [Add the date and time to the subject] check box.

From Address — Enter the Email address of the sender. When the recipient replies, the message will be sent to

this Email address.

From Name — Enter the sender’s name of the Email document.

Body — Enter the body message of the Email document. You can enter up to 1000 characters (including spaces).

File Format — Select the file format to which the received document will be converted.

* TIFF (Multi) — Select this option to save the scanned images as a multi-page TIFF file.

* TIFF (Single) — Select this option to save the scanned images separately as single-page TIFF files.

* PDF (Multi) — Select this option to save the scanned images as a multi-page PDF file.

* PDF (Single) — Select this option to save the scanned images separately as single-page PDF files.

* XPS (Multi) — Select this option to save the scanned images as a multi-page XPS file.

* XPS (Single) — Select this option to save the scanned images separately as single-page XPS files.

* JPEG — Select this option to save the scanned images as JPEG files. This option is selectable only when you
have scanned the images with either [FULL COLOR] or [GRAY SCALE].

» If the forced encryption setting is enabled, only [PDF (Multi)] and [PDF (Single)] are selectable for the file
format. For the forced encryption function, refer to the MFP Management Guide.

* Files saved in the XPS format can be used in Windows Vista, Windows 7, and Windows Server 2008, or
Windows XP SP2, Windows Server 2003 SP2 or later versions with Net Framework 3.0 installed.

Encryption — Set this option for encrypting PDF files if you have selected [PDF (Multi)] or [PDF (Single)] as the
file format setting.

* Encryption — Select this check box if you want to encrypt PDF files.
* User Password — Enter a password for opening encrypted PDF files.
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* Master Password — Enter a password for changing the encryption PDF setting.

Tips

» |f the forced encryption setting is enabled, you cannot clear the [Encryption] check box. For the forced
encryption function, refer to the MFP Management Guide.

* The user password and the master password are not set at the factory shipment. If the master password is
to be set, ask your network administrator.

* A password must be entered in one-byte alphanumeric characters. The minimum and maximum numbers of
characters allowed are 1 and 32.

e The user password must differ from the master password.

* These passwords can be re-entered only by an authorized user. Users cannot change the settings of the
[Encryption Level] box and the [Authority] box noted below if they are not authorized to change the master
password. Ask the administrator about resetting these passwords.

* For details of the encryption setting, refer to the MFP Management Guide.

* Encryption Level — Select the desired encryption level.
- 40-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 3.0, PDF
V1.1.
- 128-bit RC4 — Select this option to set an encryption level to the one compatible with Acrobat 5.0, PDF
V1.4.
- 128-bit AES — Select this option to set an encryption level to the one compatible with Acrobat 7.0, PDF
V1.6.
* Authority — Select the check box of the desired type for the encrypt PDF authority.
- Printing
- Change of Documents
- Content Copying or Extraction
- Content Extraction for accessibility
File Name — Select how the attached file will be named. Select [DocYYMMDD] to name it as described, select
[Original Document Name] to use the original document name, or you can enter the desired file name in the field.
Fragment Message Size — Select the size of the message fragmentation.
Department Code — Enter the department code if required.

6 Click [Close].

(¢ Electronic Filing

Send Email

our document has been sent successfully.

Close
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U Destination setting

On the Recipient List page, you can specify up to 400 destinations to send e-Filing documents as Email.
You can specify the recipients by entering the Email addresses manually, selecting the recipients from an address book,
selecting the recipient groups from an address book, or searching the LDAP server for recipients.

If [LDAP Authentication] is selected in [Authentication Type], you can choose only destinations that are registered in
the authenticated LDAP servers. For details of the LDAP Authentication option, refer to the TopAccess Guide.

P.82 “Entering recipients manually”

P.83 “Selecting recipients from an address book”
D P.84 “Selecting groups from an address book”
[ P.85 “Searching the LDAP server for recipients”
3 P.86 “Removing contacts from the recipient list”

Entering recipients manually

Follow the steps below to manually add a recipient to the Recipient List.
1 Click [Destination Setting] to open the Recipient List page.
2 Click [New].

Recipient List

| ave | [ Cancel |[Mew|| Address Book || Address Group || Search

| whiame Destination

The Contact Property page is displayed.
3 Enter the Email address of the recipient in the [Destination] box and click [OK].

Contact Property
‘W Cancel H Reset |

*Requ| rz
*Destination UszedI2@example.com

Ry

The entered recipient is added to the Recipient List page.

4 Repeat steps 2 and 3 to add all the recipients as required.

Tip
You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

5 Click [Savel].

Recipient List

|Save H Cancel HNEWH Address Book H Address Group || Search || Delete ‘

| ame Destination

User002@example com

The contacts are added as the destinations.
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Selecting recipients from an address book

Follow the steps below to select recipients from an address book.
1 Click [Destination Setting] to open the Recipient List page.
2 Click [Address Book].

Recipient List

Save ‘ Cancal ‘ Mew [ Address Book H Address Group || Search |
|
|i||vName |Dest|nat‘ﬁgs

The Address Book page is displayed. H

3 Select the Email check boxes of the users you want to add and click [Add].

Address Book
Group Al Groups =
[Frail  [whame Email Address
User010 UserD1 0g@example.com
T UserDSg@exsmple.com
T UserD0ag@example.com
5 | [oseror UserDT @example.com
T | [oseros UserD0E@example.com
T | |Useroos User05@example com
" | |Useroos User(04@esxample com
"7 | |Userooa UserI03@example com
Fl User0nz Liser02@esxample com
User0o UserDin @example.com
ﬁJg ofthis page

The selected recipients are added to the Recipient List page.

Tips

* If you want to sort recipients into specific groups, select the desired group name in the [Group] box.
* You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

4 Click [Save].

Recipient List

‘ Cancel \W ‘ Address Book H Address Group || Search | Delete
|

ame Destination
User004 UserD04@example com
Userd03 User003@example com
Userd0z User002g@example com

The contacts are added as the destinations.
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Selecting groups from an address book

Follow the steps below to select groups from an address book.
1 Click [Destination Setting] to open the Recipient List page.
2 Click [Address Group].

Recipient List

|Save H Cancel HNEWH Address Book H Address Group || Search

|| wtame Destination

The Address Group page is displayed.
3 Select the group check boxes containing the desired recipients and click [Add].

Address Group

Add| | Cancel |

Group [wGroup Mame

Groupd3

Sroup02
| sroupdt

wop ofthis page

All recipients in the selected groups are added to the Recipient List page.

Tip
You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

4 Click [Savel].

Recipient List

Save ‘ Cancel H@H Address Book H Address Group || Search || Delete ‘
| ame Destination

Groupl1 Group

The contacts are added as the destinations.
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Searching the LDAP server for recipients

Follow the steps below to search the registered LDAP server for recipients.

Tip
To search the LDAP server for recipients, an administrator must set up the directory service by using TopAccess in the
administrator mode. For details, refer to the TopAccess Guide.

1 Click [Destination Setting] to open the Recipient List page.
2 Click [Search].

Recipient List

| Save || Cancel | [New|| Address Book || Address Group || Sear:}ll

l|whiame Destination

The Search Contact page is displayed.

Specify the search condition.

1) Select the directory service name that you want to search in the [Directory Service Name] box.
2) Enter the search terms in the fields that you want to search.
3) Click [Search].

Search Contact

Search ‘ Cancel ‘
Entera ‘3ma or Email address to search far a contact.

Directory Service Mame  LDAPOT -
First Mame %1

Last Mame User
Ernall Address
Fax Murmber

Company

Department [

TopAccess will start searching the LDAP server for recipients, and the Search Address List page will display the
results.

Tips

* If you select the model name of the equipment in the [Directory Service Name] box, you can search the
address book of the equipment for recipients.

* TopAccess will search for the recipients that match the entries.

* Fill in at least one of the fields to perform a wild-card search.
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4 Select the Email check boxes of the users you want to add and click [Add].

Search Address List

[ell pame company department Email Address

UserD10@example.com

UserD09@example com

UserO08@example com

User007 @example com

UserO06@example com

UserD0Sg@esxample.com

User004@esample. com

UserD03@esample.com

UserD02@esample.com

User D0 @example.com

Gagada ofthis page

The selected recipients are added to the Recipient List page.

Tip
You can remove contacts once added to the recipient list before saving the destination settings.
P.86 “Removing contacts from the recipient list”

5 Click [Save].

Recipient List

Save [ Cancel ][ Address Book H Address Group ” Search ]

| ame Destination

[ |Useron4 User004@example.com
[7] |Useroos User005@example com
[7] |Useronz UserD02@example com

The contacts are added as the destinations.

Removing contacts from the recipient list

Select the check boxes of the contacts that you want to remove from the recipient list,
and click [Delete].

Recipient List
[ Cancel ]’ Address Book H Address Group ][ Search ] i Delete |
Destination Vw

User004g@example.com

User003@example com

User002g@exampie com

The selected contacts are removed from the recipient list.
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EDITING DOCUMENTS

This chapter provides instructions on how to edit documents by using the e-Filing web utility.

About the Document Control Buttons............cocciiiinicerr e 88
Editing With Pages in YOUr DOCUMENLS .......ccoeuuiiiiiiimmiicceccssn e s sesrs s sssss s s e s eesnmmmssssssssnsnnnes 89
Displaying document and page PrOPEIIES .........coueiiiiiiiiiii ettt et snee e nne s 89
Copying pages from one document t0 @NOLNET ............cooiiiiiiii e s 90
Copying pages from a document 0 @ BOX OF TOIAET..........coiuiii i e 95
Deleting pages from @ OCUMENT...........oiii i e et e e e e e e e e st e e e e e e b aeeee e s sssaeeansaeeeessnnssaeaaeannnns 99
Inserting a blank page iNt0 @ AOCUMENT.............oiiiiiiiiee e e e e e e s e e e e enreee s 101
Moving pages Within @ OCUMENT ... ittt rr e et 104
Moving and Merging DOCUMENLS.........ccccoiiieimcmuciiinirrrrrnemsssssss s s e s e e s smmasssssss s e e e e s nnmmnssssssssnnnes 107
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About the Document Control Buttons

The e-Filing web utility allows you to make changes to your stored documents before you print them.

Three document control buttons are provided in the e-Filing web utility: [Edit], [Save], and [Cancel].

These buttons are displayed at the top of the Contents frame when you select a document in the Document frame. The
buttons displayed vary depending on the document status.

» [Edit] — Click this button to start editing the document. Only this button is displayed when you are in the View mode,
where the document status indicates “View”. When you click [Edit], the document status will be changed to “Editing”,
[Save] and [Cancel] appear instead of [Edit], and you can edit the document. If you click this button when the
document status indicates “In Use”, you cannot enter the Edit mode and the message “The Document is being used.
Please try again later” is displayed.

* [Save] — Click this button to save the document that you have edited. This button is displayed only when you are in
the Edit mode, where the document status indicates “Editing”. When you click this button, the document is saved and
returns to the View mode.

¢ [Cancel] — Click this button to return to the View mode without saving the document. This button is displayed only
when you are in the Edit mode, where the document status indicates “Editing”.

The document status is displayed to the left of these buttons. The document status indicates the following situations:
* In Use — This indicates that another user is currently editing the document.
* View — This indicates that the document is currently in the View mode, and you can only view the pages within the
document.
* Editing — This indicates that the document is currently in the Edit mode, and you can edit the document.

When you edit or delete a document that is shared by other users, make sure to refresh the display to see the latest
status of the document. If the two or more users try to edit or delete the document or the page at the same time, the
data may be damaged.
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Editing With Pages in Your Documents

The e-Filing web utility allows you to copy, move, delete and insert pages and change the order of pages in your
document.

3 P.89 “Displaying document and page properties”

3 P.90 “Copying pages from one document to another”

3 P.95 “Copying pages from a document to a box or folder”

P.99 “Deleting pages from a document”

P.101 “Inserting a blank page into a document”

P.104 “Moving pages within a document”

H Displaying document and page properties

You can display the Document Properties and Page Properties windows that contain details of the document or page. To
display the Document Properties window, select the check box of the document and select [Properties] from the [File]
menu. To display the Page Properties window, select the check box of the page and select [Page Properties] from the
[File] menu.

The Document Properties window contains the following information:

Document Properties

=
i) DOC110610-001

Location e-Filing/Mser01/
Total Page(s) 3
Size 19mMB

Created 2011.05.10 09:05:09
Modified 2011.0510 09:05:11
LastAccessed: 2011.05.10 10:00:59

[oK ]

* Location
Displays the directory where the document is located.
* Total Page(s)
Displays the number of pages the document contains.
* Size
Displays the data size of the document.
* Created
Displays the date and time the document was created.
* Modified
Displays the date and time the document was last modified.
* Last Accessed
Displays the date and time the document was last accessed by any user.
* [OK]
Click this button to close the window.

The Page Properties window contains the following information:

Page Properties

D‘ DOC110510-001 (1 73)

Format: Copy
Resolution B00x EOD
Image Size 4867 x 6922
Paper Size Ad

Size BY10 KB

Lox]

* Format

Displays how the page is stored.
* Resolution

Displays the resolution of the page.
* Image Size

Displays the pixel size of the page.
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* Paper Size

Displays the paper size of the page.
* Size

Displays the data size of the page.
* [OK]

Click this button to close the window.

H Copying pages from one document to another

You can copy or cut pages from a document and insert them into another one.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages
you want to copy or cut.

(¢ Electronic Filing

Document B eFiling [ fterns)

{E3 e-Filing
o f-f Public Box
=] @j 001 User0l

¥ 5@ 002 Usero2
= — o
¥ £ 003 UserD3 f [

#l £ 004 Usero4 N7 e
2] ﬁ\j 005 Userd5
¥ 5A 006 UserDd
2] ﬁlj 007 Userd?
Fublic Box 001 UserQl

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication
Box Mumnber om

Box Mame User1

BoxPassword: || esesss

Ok D | Cancel ‘
Notes

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.

(¢ Electronic Filing Documents | Preterences RN
File Edit -,

Document F-‘DOCHDEWD-DDW (143) Status : View
{8 e-Filing

[ Public Box

E & 001 Userl P ==

] Folderdl

[& Doc110510

|y DOC110510-001
#f 002 User02 —
50 003 User03 \ I
& 004 User04
&0 005 User0s
&f 006 User0&
&0 007 Usern?

[Flpages 2 [Flpages 2

The pages of the document are displayed in the Contents frame.

o

If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] changes the
document status from the View mode to the Edit mode so that you can cut pages from the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or
[Cut] from the [Edit] menu.

8 Electronic Filing Documents | Preferences Login
File Edit  View =R

Document [FReiele] seiect an Status : Editing

Invert Selection
{8 e-Filing

@ Public Box ‘ Femn = = T
= & 001 Usero1 R &‘J!“ [ |
) Folderol —_— A =
[& Doc110510 Delete - ==
DOC110510-001 <
57 002 Usern2
&0 003 User0s
5F 004 User0a

&3} ’ -
¥ &g 005 User0s S

= Drages 1 [@lrages 2 P, 3 '
¥ &p 006 User0s = aes [lrages

&0 007 Usern? %

* When you have cut pages from the document, proceed to the next step after the process is completed.
* When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is busy.
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6 Click [Save] to save the document.

@ Electronic Filing Documents | Preferences Login
File Edit View Layout x F

Document E DOC1105810-001 (1/1) Status : Editing
{8 e-Filing
[ Public Box

E & 001 Userl
() Folderol
[& Doc110510
DOC110510-001
& 002 User02
&0 003 User0s
& 004 User04
&0 005 User0s
&f 006 User0&
&0 007 Usern?

DDageE 1

2 items are cut.

The Save Document window appears.

7 Enter the document name in the [Document Name] box and click [Save].

Save

Document Name DOC110510-001

* If you rename the document, it will be saved as a new one. If you do not change the document name, the
original document will be overwritten.
The Contents frame displays the pages in the View mode.

* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.

In the Document frame, select the box or folder containing the document into which
you want to insert the copied pages.

(¢ Electronic Filing
File Edit View
E-‘DOCHUSWEI—UEH 1)

Documents Preferences Login

Status : View

Document

= &9 001 User0l
] Folderol

| DOC110510

[a DOC110510-001
&0 002 Usernz
#f 003 User0a
&0 004 Usern4
#f 005 User0s
&0 006 Userds
& 007 User0?

DDageE 1

The Document is saved,
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber onz2
BoxMarme Userl2
Box Password asssss
oo

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

+ The password input is displayed in the blank symbols. n
Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document into which you want to insert the copied
pages, and click [Edit].

¢ Etectronic Filing Lo
File Edit > ,

Document [ DOC110510-002 (1/3) Status : View
18 e-Filing k
(@ Public Box z

= &9 001 User0l
() Foldero1
| DOC110510
[Qa DOC110510-001
= &9 002 User0z -
£ Foldernz L
| DOC110510-002
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

11 Click the space between the pages where you want to insert the copied pages.
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The arrow indicators move to the space between the pages where you clicked.
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12 Click the [Edit] menu and select [Paste].
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The copied pages are inserted between the specified pages.

1 3 Click [Save].
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« m »
The Save Document window appears.

14 Enter the document name in the [Document Name] box and click [Save].

Save

Docurnent Narme | DOCT10510-002

If you rename the document, it will be saved as a new one. If you do not change the name, the original

document will be overwritten.
¢ The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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H Copying pages from a document to a box or folder
You can copy or cut pages from a document and save them in a box or folder as a new document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document whose pages
you want to copy or cut.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication
Box Mumber o

BoxMame : User1

Box Password LTI

0K D | Cancel ‘
Notes

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 In the Document frame, select the document whose pages you want to copy or cut.
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The pages of the document are displayed in the Contents frame.

Tip
If you want to cut pages from the document, click [Edit] to enter the Edit mode. Clicking [Edit] changes the
document status from the View mode to the Edit mode so that you can cut pages from the document.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

5 Select the check boxes of the pages that you want to copy or cut, and select [Copy] or
[Cut] from the [Edit] menu.
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* When you have cut pages from the document, proceed to the next step after the process is completed.
* When you have copied pages from the document, proceed to step 8 after the process is completed.

Do not perform any operation while the e-Filing web utility is running busy.
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6 Click [Save] to save the document.
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1item is cut.

The Save Document window appears.

Status : Editing Can:e\ ‘

D.Dagea 2

7 Enter the document name in the [Document Name] box and click [Save].

Save

Document Name DOC110510-001

* If you rename the document, it will be saved as a new one. If you do not change the name, the original

document will be overwritten.

¢ The document status is returned to the View mode from the Edit mode

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.

In the Document frame, select the box or folder where you want to store the copied

pages.
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The Document is saved,

[Flpages 2
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumnber onz2
BoxMarme Userl2
Box Password asssss
[ Goncl |

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

10 Click the [Edit] menu and select [Paste].
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[Scan]

The document containing the copied pages is created in the selected box or folder.
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H Deleting pages from a document
You can delete pages from a document.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document whose pages

you want to delete.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber o
BoxMame : User1
Box Password LTI
e (]

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be

performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].

4 In the Document frame, select the document whose pages you want to delete, and click

[Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit

mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently

editing the document.

[Flpages 2
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5 Select the check boxes of the pages that you want to delete and select [Delete] from the
[Edit] menu.

8 Electronic Fifing Documentell Preferences Login
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Cut

The confirmation dialog box appears.

@ Click [OK].

Message fram webpage

‘e‘ Do you want ta delete the page(s)?

The selected pages are deleted.

7 Click [Save] to save the document.
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2 items are deleted.

The Save Document window appears.

8 Enter the document name in the [Document Name] box and click [Save].

Save

Docurnent Marme DOC1T10510-001

* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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H Inserting a blank page into a document
You can insert a blank page into a document. You can select a different size for the blank pages.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document into which
you want to insert a blank page.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber o
BoxMame : User1
Box Password LTI
e (]

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document into which you want to insert a blank
page, and click [Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.
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5 Click the space between the pages where you want to insert a blank page.
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The arrow indicators move to the space between the pages where you have clicked.

6 Click the [Layout] menu and select [Insert Blank Page].
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The Insert Blank Page window appears.

7 Select the paper size and orientation of the inserted blank page, and click [OK].

Insert Blank Page

Select the paper size for the blank sheet o insert.

) Letter (8.5 %11 in) @ Porirait
@ Legal (B.5x14in) ) Landscape:
@ A4 (210 %287 mm)
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Cancel

A blank page is inserted between the specified pages.

Tip

Its available size differs depending on the model.
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8 Click [Save].
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The Save Document window appears.

Status : Editing :
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9 Enter the document name in the [Document Name] box and click [Save].

Save

Document Name DOC110510-001

Cancel

* If you rename the document, it will be saved as a new one. If you do not change the name, the original

document will be overwritten.

¢ The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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H Moving pages within a document
You can move pages within a document to rearrange the page order.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the document whose pages
you want to rearrange.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber o

BoxMame : User1

Box Password LTI

e (]

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip
You can also enter the password of a user with an administrator privilege in [Box Password].

In the Document frame, select the document whose pages you want to rearrange, and
click [Edit].
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The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.
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Select the check boxes of the pages that you want to move between other pages and
select [Cut] from the [Edit] menu.
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The selected pages are copied to the clipboard and deleted from the document.

Do not perform any operation while the e-Filing web utility is running busy.

6 Click the space between the pages where you want to insert the copied pages.
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1 item is cut.

The arrow indicators move to the space between the pages where you have clicked.

7 Click the [Edit] menu and select [Paste].
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The copied pages are inserted between the specified pages.

8 Continue the procedure from steps 5 to 7 to rearrange the pages.

Editing With Pages in Your Documents 105



9 After you have completed rearranging the pages, click [Save].

(¢ Electronic Filing
File Edit

Documents

Preferences Login

Document & DOCTIO0510-001 (3/3)

{8 e-Filing
[ Public Box
E & 001 Userl
() Folderol
[& Doc110510
DOC110510-001
& 002 User02
&0 003 User0s
& 004 User04

&0 005 User0s
ga 006 UserO&
&0 007 Usern?

DDageE 2

DDageE 1

1item is pasted.

The Save Document window appears.

Status : Editing

1 0 Enter the document name in the [Document Name] box and click [Save].

Save

Document Name DOC110510-001

Cancel

* If you rename the document, it will be saved as a new one. If you do not change the name, the original

document will be overwritten.
¢ The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X] by mistake, turn the power to the equipment off and then on again.
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Moving and Merging Documents

You can move documents between boxes or folders. You can also combine several documents into one document.
P.107 “Moving documents”
P.109 “Merging documents”

l Moving documents

You can move a document from one box or folder to another, to help you manage the documents.

1 Click the [Documents] tab.
The [Documents] tab page is displayed.

In the Document frame, select the box or folder containing the document that you want

to move.
(¢ Efectronic Filing
_
Document B w-Filing (3 itams)
i e-Filing

g Public Box

¥ 5@ 001 Userol
= ﬁ\j 002 Userdz
B 29003 Userd3 = [

® 25 004 User04 ﬂ ﬁ'lﬁ
¥ 5A 005 UserDs
2] ﬁlj 006 Userlf
5@ 007 Userd?

Public Box 001 UserDl

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication
Box Mumber om

BoxName Userd1

Box Password LTI

QK D Cancel
Notes

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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4 Select the check boxes of the documents that you want to move and select [Cut] from
the [Edit] menu.
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The selected documents are copied on the clipboard and deleted from the current box or folder.
Do not perform any operation while the e-Filing web utility is running busy.

In the Document frame, select the box or folder where you want to paste the
documents.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber ooz
BoxName Userl2
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* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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7 Click the [Edit] menu and select [Paste].

(¢ Electronic Filing Login
Fil i

Document
{8 e-Filing
[ [ Public Box
E & 001 Userl
® ] Folderol
[Ga DOC110510-001
= & 002 User0z
& ] FolderDz _]
¥ 57 003 Userd2
E 5 004 User04+
¥ 57 005 Userds
E & 006 User(s
= gl'j 007 Userd? [FFolderoz

The documents are created in the selected box or folder.

H Merging documents

You can copy an entire document and insert its pages into another document.
The document that you want to insert is the source document, and the document that you want to merge it into is the
destination document.

Click the [Documents] tab.
The [Documents] tab page is displayed.

2 In the Document frame, select the box or folder containing the source documents.
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If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication
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* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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Select the check boxes of the source documents and select [Copy] from the [Edit]

menu.
(' Electronic Fifing Loain
File i < < > 3
Document
{8 e-Filing

¥ [ Public Box
= A 001 Usernl
# ) Folderol

[Ga DOC110510-001
[ g 002 Usernz
H & 003 User03
¥ 57 004 User04
E & 005 User0s = =
¥ 57 006 Userda
E & 007 User?

[CIFoldernl -
{¥poc110510-
ool

-

1 opyl

The selected documents are copied to the clipboard.

Do not perform any operation while the e-Filing web utility is busy.

5 In the Document frame, select the box or folder containing the destination document.

W Documents Preferences Hﬂiﬂ
File i e

Document & Userllt (2 items)

15 e-Filing

* [ Public Box

= &9 001 User0dl

| DOC110510-001 =

& g 002 User0z - |
5 003 User03 > " 1
57 004 Userd4
¥ 57 008 User0s = =
5 006 Userds
¥ 57 007 Userd?
[TIFaolderol
[Fpociiosio-
001
[Copy]

If you select a box that is protected with a password, the Password Authentication
window appears. Enter the password in the [Box Password] box and click [OK].

Password Authentication

Box Mumber ooz
BoxMame : Userd2
Bow Passward LLTTTT

* If you enter an invalid password several times to open the box, you may not log in for a certain period since
it will be regarded as an unauthorized access. When "Box is locked." appears and logging in cannot be
performed, ask your administrator.

* The password input is displayed in the blank symbols.

Tip

You can also enter the password of a user with an administrator privilege in [Box Password].
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7 In the Document frame, select the destination document, and click [Edit].

8 Electronic Fifing Documentell Preferences Login
File Ediit =

o H tatus : View i
Document & DOCT10510-002 {143 s Vi Edit
{8 e-Filing \
[ Public Box z
E & 001 Userl
() Folderol =

[ DOC110510-001

= &9 002 User0z
() Foldernz -

@ oociiosio-aog || @
&f 003 User0a
57 004 UserD4 1
&F) 005 User0s
&0 006 Userds
&f) 007 User0?

[Flpages 1 [Flpages 2 [Flpages 2

The pages of the document are displayed in the Contents frame, and the document status is changed to the Edit
mode from the View mode.

rl

If the document status indicates “In Use”, you cannot enter the Edit mode because another user is currently
editing the document.

8 Click the space between the pages where you want to merge the documents.

8 Electronic Filing Documents | Preferences Login
File Edit View Layout x F

Document [& DOCTI0510-002 (1/3) Status : Editing
{8 e-Filing - . ~
[ Public Box =
= & 001 Usero1 -
] Folderdl
[ DOC110510-001
= f# 002 Useroz o -
[ Folderoz
DOC110510-002
&f) 003 User03
¥ i 004 Useras Fs [Crages 1 [Clrages 2 [Clrages 2 P8

ga 005 User05S
&0 006 Userds
ga 007 User07?

The arrow indicators move to the space between the pages where you have clicked.

9 Click the [Edit] menu and select [Paste].

8 Electronic Fifing Documentell Preferences Login
File Edit ] i

Document [2leled] seiect an Status : Editing

Invert Selection

18 e-Filing Cut [ er— v
[ Public Box Core
E & 001 Userl
() Folderol —k—
[& DOC110510-001 Delete
g 002 Userz [
) Foldero2
DOC110510-002
&f) 003 User03
< 5 004 User0d [Crages 1 [Clrages 2 [Clrages 2 -~

ga 005 User05S
&0 006 Userds
ga 007 User07?

The copied documents are merged between the specified pages.

Tip

If multiple documents have been copied, the documents are merged in order from the oldest one.
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1 0 Click [Save].

@ Electronic Filing Documents | Preferences Login
File Edit View Layout x F

Document E DOC1105810-002 (4/5) =
{8 e-Filing

[ Public Box =

E A 001 Usero1 -
() Folderol

[ DOC110510-001

g 002 Userz g -

() Folderoz
DOC110510-002

ga 003 User03
&0 004 Usern4
ga 005 User05S
&0 006 Userds =
ga 007 User07? -

.

m

DDageE 1 DPages 2 DPages 3 DPages 4

DDageE 5

<m ' o

The Save Document window appears.

11 Enter the document name in the [Document Name] box and click [Save].

Save

Docurnent Marme | DOCT10510-002

* If you rename the document, it will be saved as a new one. If you do not change the name, the original
document will be overwritten.
* The document status is returned to the View mode from the Edit mode.

Do not close the Save Document window by clicking [X]. The operations may no longer work properly. If you
close the window by clicking [X], turn the power to the equipment off and then on again.
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SYSTEM ADMINISTRATION

This chapter describes system administration of the e-Filing features.

Safeguarding Data..........ccccciiiiiiiiii e —————————————————— 114
EFASING DOXES......eeeeii ettt ettt ettt b a et et e et e E e e e h et R et e e b e e e re e e nneeeareeennee 114
UNIOCKING USEE DOXES ...ttt ettt e ettt e e e ettt e e e e et bt e e e e e e mbee e e e e eannaeeeeeaanneneeeeeannaeeaeeanns 115



Safeguarding Data

An administrator should periodically monitor e-Filing to make sure it has enough hard disk space for everyday operations.
This section describes the administrator’s function that allows you to delete boxes and the unlocking method of the user
boxes which have been locked by incorrect password entries.

P.114 “Erasing boxes”

P.115 “Unlocking user boxes”

M Erasing boxes

You can manually erase boxes in e-Filing if the data has been corrupted, for example, by a hard disk failure and is
therefore no longer usable.
Log on to the Administrator page.

P.37 “Logging in as a system administrator”
The Box Management page is displayed.

It is recommended to archive the documents in the boxes before deleting them. Once the boxes have been
deleted, you cannot restore the documents in the boxes.
P.73 “Archiving documents”

* The Backup/Restore utility included in the Client Utilities CD-ROM allows you to back up data in the boxes.
Tip
You can display the Box Properties window by clicking the box number or box name link.

2 Select the check boxes of the user boxes that you want to delete and click [Delete].

“§ Electronic Filing

Box Management

oFiling Disk Space Awslable 10142 MB

Stoend Data Data Typa Data Size Rinarks.
Box Shaeed Fily ar Ne

:%z & o Humbas

1

]

R

The confirmation dialog box appears.

For more information about the Box Management Subtab, see the following page:
P.41 “[Box Management] subtab”

3 Click [OK].

Message from webpage ==l

.e‘ Do you want to delete the item(s)7

[ ok ][ conce |
4\)

The selected user boxes are deleted from e-Filing.
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H Unlocking user boxes

When the Lockout Setting of e-Filing is set to “Enable” in the Password Policy, if an incorrect user box password is entered
a specified number of times consecutively, the user box is locked so that it cannot be used for a certain time. The system
administrator can unlock user boxes which have been so locked.

The Password Policy can be set in TopAccess. For details of the password policy, refer to the TopAccess Guide.

1 Log on to the Administrator page.
P.37 “Logging in as a system administrator”
The Box Management page is displayed.

Tips

* For locked user boxes, “Locked” is displayed in the Status.
* You can display the Box Properties window by clicking the box number or box name link.

2 Select the check box of the user box that you want to unlock, and the click [Unlock].

_(ﬁ Electronic Filing Documents  Preferences | Adminkstration [ ETTT
Box Management
oFiling Disk Space Awslable 10142 MB
Stoend Data Data Type Data Size Renmacks
B Shanud Fili o7 Ng
Delete | | Unlock
| anamm Box Hame Used capacity Satus
1 Jsari STMD

ser02 S ¥H
Jserod SHE
¥ 004 Jsarid 4omMp Locked
Jaeris Skl
User0f 5¥8
N1

Jserny 518

The lock of the selected user box is released.

For more information about the Box Management Subtab, see the following page:
P.41 “[Box Management] subtab”
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